
    Reference    
Choose a topic name or folder to display the topic contents.
Kurzweil VoicePad Windows

Kurzweil VoicePad Main Window
Options Dialog 
Active Words Window 
Take Window
Correct That Window
Keyboard Window 
Recognition Wizard 

Command Lists
Voice Alphabet 
Kurzweil VoicePad Commands 
Command List Cue Cards

For Help on Help, press F1.



Voice Alphabet
To capitalize a letter by voice, say capital- followed by the alphabet word.    For example, 
say capital-delta    as the first letter of Donna.    See Spelling By Voice for more information.
Letter Say Letter Say

a alpha n november
b bravo o oscar
c charlie p papa
d delta q quebec
e echo r romeo
f foxtrot s sierra
g golf t tango
h hotel u uniform
i india v victor
j juliet w whiskey
k kilo x x-ray
l lima y yankee

m mike z zulu



    Customizing Kurzweil VoicePad
Choose a topic to display the topic contents.
Customizing Commands

Understanding Commands and Command Lists 
Placing a New Command in the Correct Command List
Designing a Command 
Adding a Command 
Editing a Command 
Deleting a Command 
Training New Commands

Voice-Enabling a New Application
Overview of the Process 
Adding an Open-Application Command 
Using Command Learning
Example of Voice-Enabling an Application 

For Help on Help, press F1.



    Understanding Commands and Command Lists
Introduction to Commands
Commands translate spoken words into actions. When you say down-arrow, Kurzweil 
VoicePad tells your computer to move the insertion point down one line in the 
document. When you say file-menu, Kurzweil VoicePad opens the File menu.
You can also create a command to insert text.    Example 
Command Lists Are Available in Context
Kurzweil VoicePad groups all commands into logically related lists, and makes appropriate 
lists available when you need them. For example, Kurzweil VoicePad groups all commands 
that move the insertion point in the Navigation Keys command list and commands that let 
you work with features of a particular dialog box are grouped in a command list that is 
specific to that dialog box.
For more information on command lists, choose one of the topics below.

When is a Command List Active?
Where Do I Place a New Command That I Add?



For example...
You could create a command that lets you say Kurzweil to insert "Kurzweil Applied 
Intelligence."



    When Is a Command List Active?
When you make a window active, Kurzweil VoicePad automatically switches to a valid 
set of command lists.    Not all lists are available at all times, however.    Different lists 
are available when you dictate, control menus, or use a dialog box or the Keyboard 
window.
For example, if you are dictating and say the command file-menu, the focus moves to 
the menu bar and the File menu opens.    Kurzweil VoicePad switches from a set of 
command lists that are active for dictation to a set of lists that are active for menu 
control. 
If you say a command that is not valid for the context, Kurzweil VoicePad does not 
recognize it.
To see the lists that are available in a specific location
Look in the Active Words window. If the Active Words window is not displayed, say open-
active-words. As you scroll through the list you see the name of each command list in bold 
letters.
To see a list description
Click on any item below to see a command list description.
Kurzweil VoicePad Commands
Continuous Digits
[Dialog Box Name]
Extended Keys
Free Text
Global Words
KV Dictation Commands
Menu Commands
Navigation Keys
Punctuation Keys
Voice Alphabet
Windows Commands
Windows Menu Commands



    Where Do I Place a New Command When I Add It?
When adding your own command, it is important that you place it in the correct 
command list in the Active Words window so it will be available when you need it.
There are only two command lists in which you should place any new commands: 
Kurzweil VoicePad Commands and Global Words.
To decide what list you should place a new command in, determine what action the 
command performs and place it in a list with commands that perform similar actions.
New commands can easily be added to the VoicePad Commands list by clicking the Add
Command button on the Kurzweil VoicePad toolbar.    All commands added in this 
manner will be available to you in VoicePad’s main window.
Refer to the table below as a guideline to place your command in a list.
Action the Command Performs Command List
Displays a pull-down menu or 
executes a menu shortcut key

Kurzweil VoicePad Commands

Performs a macro Kurzweil VoicePad Commands
Inserts a block of text (text 
expansion)

Kurzweil VoicePad Commands

Inserts words such as acronyms, 
company names, or work-related 
terms that other users might also 
need

Global Words

Tip:    You can add a word to the Free Text list, but the best way to do it is by 
saying the word as you dictate.    When Kurzweil VoicePad does not recognize 
the word, use correct-that to add it.    Free Text is user-specific. If you want to 
add a word that you can share with other users, place it in the Global Words 
list.

See Also 
Understanding Command Lists 



To specify the command list to place a new command in
Highlight the correct command list in the Active Words window before choosing Add from 
the Edit menu or pop-up menu.



    Designing the Command    
Follow the process below to ensure greater success when adding commands.
To design the command
1 Do a test run of the command you are designing and write down each step you do. 
2 Design the spoken phrase that you want to use to invoke the command. Make sure 

the command phrase:
Is pronounceable
Is memorable
Is acoustically distinct
Says what the user will see, whenever possible

Important: See command name guidelines.

When the design is complete
Complete the following additional steps:
4 Add the command.
5 Train the command.
6 Test and edit the command if you find mistakes.

See Also
Components of a Command



Command name guidelines

Do not use a single free text word as a command name; instead create a command 
phrase with at least two words.
Guard against adding duplicate commands with slight capitalization or spacing 
variations by using the following conventions:

Lowercase all words.
Put hyphens between words.

EXAMPLE:    tools-options



    Components of a Command
When you add or edit a command you supply a number of command components.    If 
you intend for other users to be able to use the added or edited commands, it is helpful 
to understand these components.    Maximize this Help window to see all columns in the
table.

Component Description Example Defined/Stored
command name

(spelling in the Active 
Words window; 
lowercase with 
hyphens)

bold-italic Defined on the Add/Edit 
Command dialog and stored in
a file that can be shared with 
other users

command actions
(key presses 
performed by the 
command)

press Ctrl + B, then
press Ctrl + I

Defined on the Add/Edit 
Command dialog and stored in
the same shareable file as the 
command name

command model
(speech sample of 
words you speak to 
invoke the command)

bold-italic Created when each user trains
the new command, and stored
with each user's voice profile 
(not shared by other users)

See Also
Sharing New Commands with Other Users



    Adding a Command
Kurzweil VoicePad supports two basic ways of adding new commands:

To add commands that are available in the main dictation window, simply click the
Add Command button on the VoicePad toolbar.
To add a command to a different command list, insert the command using the 
Active Words window.

The Active Words window lets you add your own command to a selected command list.  
For information on selecting the appropriate list, see Placing a New Command in the 
Correct Command List.

Note: If you see a red diamond ( ) next to a command, you do not need to 
add it, but you must train it before you can use it.

Before you start the procedure, open Kurzweil VoicePad and make it active.    If you are 
adding a command to use in a dialog box, open that dialog box.
To open the Add Command dialog
1 Say open-active-words or click on the Active Words window.
2 Highlight the command list that you want to add the new command to.
3 Choose Add from the Edit menu or from the pop-up menu.    The Add Command dialog

appears.    Click to see a picture with details 

To define the new command name and type
4 In the Word is spelled text box, enter the command name by keyboard or by voice 

alphabet.    This entry will appear in the command list in the Active Words window, 
and the phrase is what you will say to use the command.

Important: See command name guidelines.

5 In the Word is box, select one option to specify whether the command:
Performs a command action (select 'a command')

Note: The action can include inserting text.    For example, if you your command 
inserts text and changes the text style to bold, you should select 'a command.'
Only inserts text (select 'text')    When you make this selection, the Add Command 
dialog changes to provide appropriate options in the Define Action box. Click to see a 
picture with details .    Skip to step 9.

If the command performs an action
6 In the Define Action box, say or press the key sequence that you want the spoken 

command to perform.    See Define Action guidelines and examples.    If you need to 
change your input to this box, use the Clear button and say or press keys again.

7 If you want Kurzweil VoicePad to ask you whether you really want to complete the 
command each time you use it, select the Confirms before option.

8 If the command action moves the insertion point in Kurzweil VoicePad, select the Clears 
Alternatives option.    Doing so tells Kurzweil VoicePad to clear alternatives from the Take 
window when the command is executed. Skip to step 11.

If the command inserts text
9 In the Define Action box, type or spell by voice alphabet the text the command should 

insert.    
10 If you want to override automatic capitalization and spacing when the text is inserted, 



select one or more of the following options:
No spaces before:    Inserts the text without a space before it.
No spaces after:    Inserts text without a space after it.
Initial cap after:    Capitalizes the first letter of the word that follows the inserted text.
Space Caps will ignore:    Causes automatic capitalization rules to skip the inserted text 
when determining spacing and capitalization of surrounding words.

To save the command
11 Choose OK to save the new command and return to the Active Words window.

To train the new command
Before you can use the new command you must train it.    See Training New Commands.
To share the new command with users on other PCs
See Sharing New Commands with Users on Other PCs.

Important:    When you add and train a command, Kurzweil VoicePad edits 
your installation to include your customizations.    To protect your customized 
commands from loss, you or your system administrator should back up 
Kurzweil VoicePad regularly.    

See Also
Adding a Global Words Command
Examples of Adding a Command 
Editing a Command



Define Action guidelines and examples

Kurzweil VoicePad uses characters to represent extended key sequences. The table 
below lists examples of the character(s) that appear in the Define Action box when you 
press keys or say commands for keys to define an action.
If you press or 
say...

This displays...

F6 {F6}
Shift+F6 +{F6}
Ctrl+Shift+F6 &+{F6}
Ctrl+F6 &{F6}
Ctrl+R &r
Ctrl+Home &{HOME}
Alt+F6 %({F6})
Alt,E,W %()ew

To enter the BACKSPACE key as an action, press CTRL + BACKSPACE or say control-
backspace.
You cannot use the following keys to define a command.
F1, ALT + TAB, ALT + SPACEBAR, PRINT SCREEN



    Adding a Global Words Command    
To make work-related words such as company names, acronyms, or business terms 
available to other users, you can add them to the Global Words list.    Unlike additions to
the Free Text list, which are user-specific, Global Words are commands that can be 
shared.
Each user must train new Global Words before using them.
To add a Global Words command
1 Open Kurzweil VoicePad and make it active.
2 Say open-active-words or click on the Active Words window.
3 Highlight the Global Words list.
4 Choose the Add from the Edit menu or from the pop-up menu.    The Add Command 

dialog appears.
5 In the Word is spelled text box, enter the command name by keyboard or by voice 

alphabet.    This entry will appear in the list in the Active Words window, and the 
phrase is what you will say to use the command.

Important: See command name guidelines.

6 In the Word is box, select 'text.'    Click here to see a picture of the Add Command dialog 
after you select 'text.'

7 In the Define Action text box, type the text you want the command to insert, with 
appropriate capitalization, punctuation, and spaces.

8 Select the Clears Alternatives check box.
9 Choose OK to save the new command and return to the Active Words window.

Important:    When you add commands, Kurzweil VoicePad edits your 
installation to include your customizations.    To protect your customized 
commands from loss, you or your system administrator should back up 
Kurzweil VoicePad regularly.

To share the new command with users on other PCs
See Sharing New Commands with Users on Other PCs.
To train the new command
Before any user can use the new command that user must train it.    See Training New 
Commands.



    Training New Commands
Before you can use a new command with Kurzweil VoicePad you must train it.    One way
to train a set of new commands is to train all untrained commands.    Untrained 
commands are those marked by a ( ) on the Active Words window.
First steps to train any command
1 Open Kurzweil VoicePad and make it active.
2 Say open-active-words or click on the Active Words window.

To train untrained commands
Follow steps 1 and 2 above, then:
3 Choose Untrained from the Train menu.
4 Follow the prompts to record speech samples.

Tip:    You can also train only untrained menu commands by following steps
1 and 2 above and then choosing Menu Commands from the Train menu.

To train only selected commands
If you have added only a few commands, or if you want to train only one command list at a 
time, you can train selectively by following    steps 1 and 2 above, then:
3 Find and highlight the command you want to train, or highlight the name of a command 

list.
4 Choose Selected from the Train menu or Train from the pop-up menu.
5 Follow the prompts to record speech samples.

Tip:    You can also train only selected menu commands by following steps 
1 and 2 above and then choosing Menu Commands from the Train menu.

Important: Speech samples that you record are unique to you and are saved 
in your voice profile.    To protect your speech data from loss, you or your 
system administrator should back up your profile regularly.



    Changing the Way Kurzweil VoicePad Spells a Free Text Word
Sometimes you prefer a spelling different from the spelling Kurzweil VoicePad provides 
for a free text word.    For example, you may prefer to spell controlling with one l.
To change the way Kurzweil VoicePad spells a free text word
1 Delete the word.    See Deleting a Word or Command from a Command List.
2 Add the word again with your preferred spelling as follows:

a)Dictate the word again.
b)Say correct-that to display the Correct That window.
c)Type the new spelling into the Take Keys box.
For more details, see Correcting When the Right Alternative Doesn't Appear.

Important: New words and speech samples that you supply when you use 
correct-that are unique to you and are saved in your voice profile.    To protect 
your customized data from loss, you or your system administrator should back
up your profile regularly.



    Editing a Command    
Editing command actions
When you speak a command phrase, Kurzweil VoicePad translates it into keystrokes and
sends the appropriate key sequence to your computer. For example, when you say file-
open, Kurzweil VoicePad sends the key sequence ALT, F, O to your computer just as if 
you had pressed those keys.
You can use the Edit Command dialog to change the actions that a command performs 
when you speak it.
Editing a command name
You can also change the way a command is spelled in the Active Words window.    Doing
so does not change the way you speak the command phrase or the actions the 
command performs.
To open the Edit Command dialog
1 Open Kurzweil VoicePad and make it active.    If the command you want to edit is for a

label in a dialog box, open the dialog box and make it active.
2 Say open-active-words or click on the Active Words window.
3 Find and highlight the command you want to edit.
4 Choose Edit from the Edit menu or from the pop-up menu.    The Edit Command dialog

appears, with the current command definition displayed.

Note:    The Edit command is dimmed if the command you selected cannot be
edited.

To edit the command
5 Change spelling or actions as follows:

Spelling
In the Word is Spelled text box, enter the correct spelling by keyboard or by voice 
alphabet.

Actions
a)Choose the Clear button to delete the action the command currently performs.
b)In the Define Action box, press or say the key sequence that you want the spoken 

command to perform. See the Define Action guidelines and examples.
c) If you want Kurzweil VoicePad to ask you whether you really want to complete the 

command each time you use it, select the Confirms Before option.
d)If the command action moves the insertion point in your document, select the Clears 

Alternatives option.
6 Choose OK to save your changes and return to the Active Words window.

Note: You do not need to retrain an edited command, but if you edit the 
actions you should test the command to be sure it performs the actions 
correctly.

To share the edited command with other users
See Sharing New Commands with Users on Other PCs.

Important:    When you add a command, Kurzweil VoicePad edits your 
installation to include your customization.    To protect your customized 



commands from loss, you or your system administrator should back up 
Kurzweil VoicePad regularly.

See Also
Spelling by Voice 



Find a command
Use this method on the Active Words window, the Menu Command Training dialog, or the 
VOICE Command Training dialog:

Begin typing the command or spelling it by voice alphabet.    As you supply letters, the 
list changes to display only the commands that match what you type.    The commands 
appear grouped by command list.

Note: To restore the full list of available commands, press or say escape-key 
or clear, or choose Clear from the Edit menu.



    Deleting a Command or Word
If you add a command to a command list by mistake, or if you need to delete a free text
word from your vocabulary in order to re-add it with a different spelling, follow these 
steps to delete the command or word:

Note: You cannot delete any commands from the KV Dictation Commands 
list.

To delete a command or word from a list
1 Open Kurzweil VoicePad and make it active.    If the command you want to delete is 

for a label in a dialog box, open the dialog box and make it active.
2 Say open-active-words or click on the Active Words window.
2 Find and highlight the command or word you want to delete.
3 Choose Delete from the Edit menu or from the pop-up menu.
4 Choose OK from the confirmation dialog box.

See Also
Adding a Command 
Editing a Command
Changing the Way Kurzweil VoicePad Spells a Free Text Word 



     Kurzweil VoicePad Basics

Choose a topic to display the topic contents.
Getting Started

Understanding How Kurzweil VoicePad Works
Understanding the Kurzweil VoicePad Windows
Setting Kurzweil VoicePad Options
Opening and Closing Kurzweil VoicePad Windows
Controlling the Microphone
Understanding What You Can Say

Dictating With Kurzweil VoicePad
Dictating to Kurzweil VoicePad
Speaking So Kurzweil VoicePad Can Understand You
Spelling by Voice
Punctuating, Capitalizing, and Spacing Text
Adding a Word That Is Unknown to Kurzweil VoicePad

Correcting and Editing
Overview of Correcting and Editing
Correcting:    Fixing Kurzweil VoicePad Recognition Errors
Editing:    Rewriting Your Text

Speaking Commands
Controlling the Menus
Pressing Keys by Voice
Kurzweil VoicePad Dictation Commands
Navigating in and Controlling Windows
Navigating in and Controlling Dialog Boxes 

For Help on Help, press F1.



    Understanding How Kurzweil VoicePad Works
Kurzweil VoicePad is a voice-enabled word processing application. Now, rather than 
press a key or use a mouse to create a document, you can use the most natural 
communication device you have -- your voice.
You can also use the Active Words window to add your own commands, voice macros, 
and acronyms.
Where to go from here
To use Kurzweil VoicePad successfully, you must understand some key concepts such as
phrasing your words and commands, correcting errors, and rewriting your text. 
Complete Kurzweil VoicePad Demo and Practice and read the following Help topics to 
assist you in getting acquainted with Kurzweil VoicePad. 
Learning to Use Kurzweil VoicePad Through Demo and Practice
Understanding the Kurzweil VoicePad Windows 
Controlling the Microphone 
Speaking So Kurzweil VoicePad Can Understand You 
Understanding What You Can Say 
Dictating to Kurzweil VoicePad 



    Learning to Use Kurzweil VoicePad Through Demo and 
Practice

Kurzweil VoicePad ships with two components to help you to quickly learn basic 
dictation and editing skills: Demo and Practice.    Demo and Practice are accesible from 
either:

The bottom of the opening Overview screen seen when you launch Kurzweil 
VoicePad
The VoicePad menu

The Kurzweil VoicePad Demo provides a brief example of the pace and cadence of 
discrete speech.    It demonstrates the speaking style that is necessary to ensure 
outstanding recognition accuracy and acceptable levels of dictation throughput with the
product.    As the demo runs, you should pay attention to the speed of dictation, the 
length of the pauses between words, and the discrete speaking style.
The Kurzweil VoicePad Practice consists of six short written exercises that will help new 
users to learn and practice dictation and editing basics. To do the exercises, read the 
onscreen instructions, place your cursor after the ‘>‘ as indicated, and dictate the 
samples as directed.

See Also
Getting Online Help 



    Getting Online Help
Kurzweil VoicePad provides online and context-sensitive Help. You can quickly 
distinguish Kurzweil VoicePad Help by the Kurzweil VoicePad icon in the top left corner 
of the screen.
To display Kurzweil VoicePad Help Contents
1 Make the Kurzweil VoicePad main window active.
2 Say help-menu to open the Help menu.
3 Say contents to open Help with the Contents topic displayed.

To display context-sensitive Kurzweil VoicePad Help
Do one of the following:

Click on the Help button in the window or dialog box.
Press F1.

To use the pop-up menu in Help
1 Click the right mouse button.
2 Select your choice and click the left mouse button.

For information on hands-free use of any Windows Help
See Using Help Hands-Free.

See Also
Learning with Kurzweil VoicePad Demo and Practice 



    Using the Kurzweil VoicePad Windows
When you first start Kurzweil VoicePad, you'll notice that the Take window and Active 
Words window appear on the right side of the Kurzweil VoicePad display. Refer to these 
windows when using Kurzweil VoicePad. 
Choose one of the topics below to learn more about that window.
Take Window

Displays the word Kurzweil VoicePad heard, as well as the alternatives to that word.
Active Words Window

Lists all currently active commands.    This window also lets you add, edit, and train commands.
Keyboard Window 

Lets you say commands for extended keys such as F1.    This window also lets you spell using the 
voice alphabet

See Also
Kurzweil VoicePad Dictation Commands 
Setting Kurzweil VoicePad Preferences 



    Setting Capitalization and Spacing Options
Use the Capitalization tab to change Kurzweil VoicePad default capitalization and 
spacing. By default, Kurzweil VoicePad inserts one space between words and two 
spaces between sentences and capitalizes the first word in a new sentence.

Note:    The choices you make on this tab affect all users who work on this 
PC .    Different users who share the same PC can reset these options at their 
convenience.

You can also use voice commands to change capitalization and spacing 
settings while you are using Kurzweil VoicePad. See Capitalizing Text and 
Spacing Text.

Spacing Options 

Option When selected:
Auto Spacing Adds a space between words .
Two Spaces 
Between 
Sentences

Adds two spaces between a sentence that ends with a 
period, question mark, or exclamation point. 

Capitalization Options

Option When selected:
Auto Cap On Capitalizes the first word of a new sentence when you 

dictate end punctuation (period, question mark, 
exclamation point). 

Initial Cap On Capitalizes the first letter of each word you dictate.
Manual Cap On Does not automatically capitalize text. You must use 

voice commands or the keyboard instead.
Lowercase On Inserts all text you dictate in lowercase.
Uppercase On Inserts all text you dictate in uppercase.

To select or unselect an option
1 With the Kurzweil VoicePad main window active, say VoicePad-menu (pause) options or 

choose Options from the VoicePad menu. 
2 Choose the Capitalization tab.
3 Place or remove an X by either:

Saying the option name. For example, say auto-spacing.
Using the mouse or keyboard.

4 Choose OK to activate the new settings and close the Options dialog.

To reset all values on this tab to default settings
Choose the Defaults button instead of placing or removing an X in Step 3 above.



    Adjusting Microphone Gain Inside Kurzweil VoicePad    
If Kurzweil VoicePad has checked the Control Gain option on the Microphone tab, you can
control gain settings inside Kurzweil VoicePad.    If the Control Gain option is not checked, 
Kurzweil VoicePad has detected that you need to adjust microphone gain in another 
way.    See Adjusting Microphone Gain Outside of Kurzweil VoicePad.
Do not change the Control Gain setting arbitrarily.    See Re-enabling the Microphone Gain
Control for more information.

Note:    If you suspect there is a problem with your microphone, be sure the 
microphone is plugged in according to manufacturer's instructions and the 
microphone control is turned on in your sound board volume control or mixer 
applet.    See also:

Troubleshooting a Deaf Microphone
Checking Sound Board Fidelity

If you are uncertain what is causing a particular recognition problem, use the 
Recognition Wizard. The Recognition Wizard lets you select from a list of 
problems and leads you through any corrective actions.

When to adjust gain
Lower the gain if:

You frequently see the message 'Too Loud' in the Kurzweil VoicePad main window.  
This occurs if you are using Kurzweil VoicePad in a noisy environment or you 
normally speak loudly.
The microphone indicator stays red.

Raise the gain if:
You can't get a good sound levels check. 

When to adjust sidetone gain
Adjust to 
Lower 
Sidetone if:

You have an Mwave board and you find the 
sidetone sound is causing you to speak more
softly than you normally speak.

Adjust to 
Higher 
Sidetone if:

You have an Mwave board and you cannot 
hear your voice at all in the earpiece.

To adjust gain or sidetone gain
1 With the Kurzweil VoicePad main window active, say VoicePad-menu (pause) options or 

choose Options from the menu. 
2 Choose the Microphone tab.
3 Change a setting using one of the following methods.
Voice:
Say what 
you see

Say one of the labels you see above the slider.    For 
example, say lower-gain or higher-sidetone.
The slider moves one unit in the respective 

direction.
Mouse:
Click and 
drag

Click on the slider control, hold down the left mouse
button, and move the slider in the appropriate 
direction.

4 Choose OK to activate the new settings and close the Options dialog.



To reset all values on this tab to default settings
Choose the Defaults button instead of adjusting a slider in Step 3 above.

See Also
Identifying Recognition Problems 



    Reenabling the Microphone Gain Control Within Kurzweil 
VoicePad    

If you change your sound board or reinstall your sound board software, you should 
verify that Kurzweil VoicePad reenables the microphone gain control within Kurzweil 
VoicePad.
To reenable the microphone gain control
1 With the Kurzweil VoicePad main window active, say VoicePad-menu (pause) options or 

choose Options from the VoicePad menu to display the Options dialog.
2 Choose the Microphone tab.
3 If the Control Gain option is unselected, select it to place a check in the box.
4 Choose OK to close the Options dialog.
5 Exit from Kurzweil VoicePad.
6 Restart Kurzweil VoicePad for the changes to take effect.

Note:    If Kurzweil VoicePad is unable to control your microphone gain 
internally, it will inform you of this problem when you restart.    To set your 
microphone gain properly, see Adjusting Microphone Gain Outside Kurzweil 
VoicePad.



    Adjusting Microphone Gain Outside Kurzweil VoicePad    
Usually you can use Kurzweil VoicePad to control your microphone gain.    If, however, 
your PC's sound board does not conform to accepted Windows mixer conventions, 
Kurzweil VoicePad notifies you that you need to adjust the gain outside of Kurzweil 
VoicePad.    To do so, follow the procedure below.
Follow this procedure if

Kurzweil VoicePad has detected that it can't control your microphone gain, and 
the Control Gain option on the Microphone Options tab is not checked.
You can't get a good sound levels check in the Kurzweil VoicePad Sound Levels 
dialog.

To adjust gain outside of Kurzweil VoicePad
Getting ready in your sound board mixer applet

1 Follow these steps to access your sound board's microphone gain (volume) control:
a)Open Volume Control from the Start menu by choosing

Programs->Accessories->Multimedia->Volume Control
If the Volume Control applet is not present, load it from your Windows 95 installation 
CD or diskettes, or use the steps for Windows 3.1 below.

b)From the Options menu choose Properties.
c)Select the Adjust Volume for:    Recording option button.
d)Select Recording Control and Microphone from the option boxes at the bottom of the 

dialog, and make sure all other options are unselected.
e)Choose OK.    The Recording Control dialog appears.
f) From the Options menu, choose the Advanced Controls toggle and make sure it is 

checked.    The Advanced button will appear on the dialog.
g)Choose the Advanced button.
h)Unselect Automatic Gain Control (AGC), if that feature is present.
i) Choose Close.    The Recording Control dialog appears again.
j) Set the Recording Volume slider (on the left) to the maximum (top) setting.
k)Make sure the Select option is checked under the Microphone Volume slider (on the 

right).    Leave this dialog visible so you can adjust the Microphone Volume slider in step 
3c.

Getting ready in Kurzweil VoicePad
2 If the Sound Levels dialog is not already open, choose Sound Levels from the Kurzweil

VoicePad menu. Leave the Sound Levels dialog visible so you can see the prompts 
and sound levels meter while you adjust the slider in step 3c.
Making side-by-side adjustments

3 With the Sound Levels dialog and microphone gain (volume) slider visible, perform 
these steps:
a)Follow the prompts to do a sound levels check, observing the contrast between silence

and spoken words displayed in the sound levels meter.
b)If the contrast is more that 2 ticks, choose OK to exit the Sound Levels dialog.    

Otherwise continue with step 3c.



c) Increase the microphone gain (volume) setting by adjusting the slider.
d)Repeat step 3a.

Note:    When the Control Gain box is unchecked on the Microphone tab, 
microphone gain is not controlled from within Kurzweil VoicePad.    You may 
need to repeat this procedure if you manually reset microphone gain settings 
or if these settings are changed by another Windows application.



notification 
When you first load a new user profile, Kurzweil VoicePad notifies you if you need to adjust 
microphone gain outside Kurzweil VoicePad.



multiplier maximum
On some sound boards, this value is 4X.    On other boards it is 8X.



Sound boards supported by Kurzweil VoicePad
Kurzweil VoicePad is compatible with sound boards from Creative Labs, as well as other 
Windows-compatible 16-bit sound boards.



    Setting Kurzweil VoicePad Preferences
Use the Preferences tab to set the appearance of Kurzweil VoicePad on your desktop 
and to choose hands-free, and profile saving options.

Note:    The choices you make on this tab affect all users who work on this 
PC .    Different users who share the same PC can reset these options at their 
convenience.

Preferences Options

Option When selected:
Always On Top Kurzweil VoicePad appears on top of all other 

applications.
Status Bar Displays the status bar on the Kurzweil VoicePad 

main window.
Train Without Confirms You train words without having to press the Continue

button after each sample you record.
Note:    This option is intended for a user who wants 
to run a PC hands-free. If you don't need this feature,
do not select this option.

Startup With 
Recognition On

The microphone is turned on automatically when you
start Kurzweil VoicePad.
Note:    This option is intended for a user who wants 
to run a PC hands-free. If you don't need this feature,
do not select this option.

Confirm Profile Save When you exit, displays a confirm dialog box that 
asks whether you want to save your voice profile; 
otherwise Kurzweil VoicePad saves your profile 
automatically.    More information 

Open Active Words Displays the Active Words window.
Open Take window Displays the Take window.
Open Keyboard Displays the Keyboard window.

To select or unselect a Preferences option
1 With the Kurzweil VoicePad main window active, say Voicepad-menu (pause) options or 

choose Options from the VoicePad menu. 
2 Choose the Preferences tab.
3.Place or remove an X by either

Saying the option name. For example, say startup-with-recognition-on.
Using the mouse, keyboard, or voice keyboard.

4.Choose OK to activate the new settings and close the Options dialog.

To reset all values on this tab to default settings
Choose the Defaults button instead of placing or removing an X or adjusting the slider in 
the instructions above.

See Also
What Does Kurzweil VoicePad Look Like? 



When to use the Confirm Profile Save option
If more than one person uses the same PC, selecting this option provides a measure of 
insurance against one user's inadvertently amending another person's voice profile by 
asking you to confirm that you want to save the profile.    Under normal conditions you 
should save your profile after each session.    Confirm Profile Save allows you to be sure you 
are not saving changes to someone else's profile, and it lets you make no changes to your 
own profile if your voice is temporarily abnormal.



    Setting Recognition Options
Use the Recognition tab to adjust match threshold, word gap, and the speed:accuracy 
ratio.

Note:    If you are uncertain what is causing a particular recognition problem, 
use the Recognition Wizard. The Recognition Wizard lets you select from a list 
of problems and leads you through any corrective actions.

When to adjust match threshold
Lowering the match threshold makes Kurzweil VoicePad less selective when matching 
the word you say with a word in the free text vocabulary that is stored with your voice 
profile; raising the match threshold makes Kurzweil VoicePad more selective when 
matching.

Adjust to 
Less 
Selective 
if:

Kurzweil VoicePad displays 'Word not recognized' in 
the Kurzweil VoicePad main window for many words 
that you say.

Adjust to 
More 
Selective 
if:

Kurzweil VoicePad frequently hears a noise as a word
and inserts it in your document.

When to adjust word gap
In most cases, you will not need to raise word gap, but you may want to try to lower it to 
about 150 to boost your dictation throughput.

Adjust to 
Shorter 
Gap if:

You want to shorten the pause between words as 
you dictate in order to boost dictation speed.
Before you make this adjustment, note the current 
setting.    Then test the new setting with multi-word 
phrases such as edit-select-all.    If such a phrase is 
recognized as separate words, raise the word gap 
setting again.

Adjust to 
Longer 
Gap if:

You normally speak slowly, especially if Kurzweil 
VoicePad recognizes your phrases as two distinct 
words rather than as a word phrase.
For example, you should raise the word gap if you 
say take-2, and Kurzweil VoicePad consistently 
recognizes the phrase as two words: take and two.

When to adjust the speed:accuracy ratio
At installation, Kurzweil VoicePad bases the initial recognition speed:accuracy value on the 
speed of your computer and the sound board installed.

Adjust to 
Faster if:

You want Kurzweil VoicePad's response time to 
be even faster, at the cost of some recognition 
accuracy.

Adjust to 
More 
Accurate if:

You want to improve recognition accuracy, at the
cost of slower application reponse time.

To adjust match threshold, word gap, or the speed:accuracy ratio
1 With the Kurzweil VoicePad main window active, say VoicePad-menu (pause) options or 

choose Options from the menu. 



2 Choose the Recognition tab.
3 Change a setting using one of the following methods.
Voice:
Say what
you see

1 Say the label you see next to the slider you 
want to adjust -- either match-threshold, word-
gap, or speed-accuracy.

2 Say one of the labels you see above the 
specified slider.    For example say less-
selective, longer-gap, or faster.
The slider moves one value in the respective 
direction.

Mouse:
Click and
drag

1 Click on the slider control and hold down the 
left mouse button.

2 Move the slider in the appropriate direction.

4 Choose OK to activate the new setting and close the Options dialog.

To reset all values on this tab to default settings
Choose the Defaults button instead of adjusting a slider in Step 3 above.

See Also
Speaking So Kurzweil VoicePad Can Understand You 
Setting Kurzweil VoicePad Options



    Opening and Closing Kurzweil VoicePad Windows
You can display and close Kurzweil VoicePad windows by:

Using open-[window] and close-[window] commands
Selecting settings on the Preferences tab in the Options dialog.

Note: Use the Preferences tab on the Options dialog to establish a setting 
that will be in effect for later sessions of Kurzweil VoicePad.    You can override 
this setting as you work by saying the open-[window] and close-[window] 
commands.

To open or close the... Say...
Take window open-take

close-take
Active Words window open-active-words

close-active-words
Keyboard open-keyboard

insert-close or cancel

To set open/close options from the Options dialog
1 With the Kurzweil VoicePad main window active, say VoicePad-menu (pause) options 

or choose Options from the VoicePad menu.
2 Choose the Preferences tab.
3 Say or click on the setting name to select or unselect it. 
4 Choose OK to activate the new setting and close the Options dialog.

To dictate to Kurzweil VoicePad after opening or switching focus to these 
windows
Except for the Take window, the open-[window] command also switches focus to make 
these windows active so you can use them.    To return focus to Kurzweil VoicePad to 
continue dictating, you can either:

Use the close-[window] command listed above.
Use the open-Kurzweil VoicePad command, which returns focus to the Kurzweil 
VoicePad dictation window without closing any other Kurzweil VoicePad windows.

See Also
Understanding the Kurzweil VoicePad Windows 
Setting Kurzweil VoicePad Options 



    Controlling the Microphone
Choose one of the topics below to display information on how to control the 
microphone.
Using the Microphone 
Turning the Microphone On and Off 



    Using the Microphone
Follow the guidelines below to use the microphone correctly and maximize Kurzweil 
VoicePad's recognition accuracy. Incorrect use can impair Kurzweil VoicePad's ability to 
recognize you. 
If you experience poor recognition after following these guidelines, use the Recognition 
Wizard to identify and solve the problem.

Make sure you have the microphone plugged in correctly.
Place the microphone mount on the left or right side of your mouth.
Turn the flat surface of the microphone toward the corner of your mouth, as close 
as you can without touching. If what you say is often misrecognized, check the 
microphone position. 
Make sure the microphone is turned on.
Wait for the green microphone indicator to appear before speaking. 

See Also
Turning the Microphone On and Off 
Starting Kurzweil VoicePad With the Microphone On 
Speaking So Kurzweil VoicePad Can Understand You 



    Turning the Microphone On and Off
You can turn the microphone on and off by keyboard, by mouse, or by voice commands.
Turn on the microphone when you want to dictate or speak commands. Turn off the 
microphone when you are not using it. Look at the microphone indicator just above the 
Kurzweil VoicePad main window to verify whether Kurzweil VoicePad is listening or not. 

    Microphone is on; OK to talk to your computer.
    Recognition is busy; wait to talk to your computer.
    Microphone is off.

To use the keyboard
Press CTRL + ALT to switch between on and off. 

To use the mouse
Click on the microphone indicator above the Kurzweil VoicePad main window to turn the 
microphone on or off.
To use voice commands
You must first turn on the microphone using the keyboard or mouse before you can use 
the voice commands.

Off: Say stop-listening. The Last Word Heard panel then displays the message, 
"Say 'Listen to me' to dictate."

On: Say listen-to-me. The Last Word Heard panel then displays the message, "Say 
a word and then pause."

See Also
Using the Microphone 
Starting Kurzweil VoicePad with the Microphone On
Speaking So Kurzweil VoicePad Can Understand You 
Using the Kurzweil VoicePad Main Window 



    Speaking So Kurzweil VoicePad Can Understand You
Tips for speaking to Kurzweil VoicePad 

Tips on: Guidelines:
Phrasing Pause briefly, approximately 1/6 of a second, after each 

word or command phrase you speak. These pauses tell 
Kurzweil VoicePad when a word or phrase begins and ends. 
If you pause after part of a word, Kurzweil VoicePad thinks 
that you have spoken a complete word and evaluates the 
part as if it were a complete word.
Words: Pause between words.
Example: Say to (pause) whom (pause) it (pause) may 
(pause) concern.
Command phrases: Pause between command phrases.
Example: Say file-menu (pause) open.
Numbers: Say a sequence of digits and delimiters with no 
pause.
Example: Say 4,326 as four-comma-three-two-six.    See 
Phrasing Numbers for more information.

Speaking 
rate

Speak at a natural rate.    If you speak too quickly or too 
slowly, Kurzweil VoicePad will misrecognize you. To adjust 
the length of the pause for better recognition or to boost 
dictation speed, see Setting Recognition Options.

Pronouncin
g 
words

Pronounce words as you normally do.

Volume Speak as you would normally speak to someone sitting 
across the desk from you. Do not speak too loudly or too 
softly.

Noises Be aware of any extra sounds you might make, such as 
tongue clicks, clearing your throat, inserting "uhs" or "ahs" 
between words, or "thinking aloud." Also be aware of any 
background sounds, such as colleagues conversing or a 
radio playing. Loud extraneous noises or soft unintentional 
noises can cause misrecognitions.

Tip:    Use the take- and correct-that commands to correct Kurzweil VoicePad 
misrecognitions. Remember that Kurzweil VoicePad learns your voice and 
adjusts your voice profile so that it recognizes you better. Kurzweil VoicePad 
also automatically adjusts to changing noise conditions on an ongoing basis.

See Also
Helping Kurzweil VoicePad Adapt to Your Voice 
Identifying Recognition Problems 
Controlling the Microphone 



    Understanding What You Can Say
You can say any English word when you dictate, and you can also say any:

Menu commands
Shortcut commands
Dialog box labels

Dictating words:    If Kurzweil VoicePad doesn't insert the word you said, you may see it 
listed as an alternative in the Take window.    Say take- and the number of the 
alternative to swap the correct word into your document.    For example, say take-2.    If 
Kurzweil VoicePad neither recognizes the word nor displays an alternative, you can 
correct or add the word using the correct-that command.    For more information, see 
Correcting:    Fixing Kurzweil VoicePad Misrecognitions and Adding a Word That Is 
Unknown to Kurzweil VoicePad.
Using menu commands:    Because commands follow the general rule of "say what you 
see," the first place to look is Kurzweil VoicePad's menus. If you want to display the file 
menu, say file-menu. Then "say what you see" to choose an option from that menu. For 
example, say open

Tip:    Say escape-key or press ESC to back out of a menu.

Using shortcut commands:    Kurzweil VoicePad also provides shortcut commands that 
combine the menu and option as one command phrase. These shortcut commands 
correspond to the options that have shortcut keys on the menus. For example, you can 
say file-open instead of file-menu (pause) open.
Using dialog boxes:    To control dialog boxes by voice you can "say what you see."    
Speak the text that labels any dialog box control, such as a tab, text box, or button.    
See Controlling Dialog Boxes for more information.
Using key commands:    See Pressing Keys by Voice for more information. 
To find what you can say
See Finding What You Can Say.
To display cue cards to remind you of commands
See Opening Command Cue Cards.

See Also
Speaking So Kurzweil VoicePad Can Understand You
Understanding Command Lists 



    Dictating to Kurzweil VoicePad
To dictate to Kurzweil VoicePad
1 Position the microphone properly.
2 Turn on the microphone and    watch for the green microphone indicator.
3 Open Kurzweil VoicePad.
4 Begin dictating, pausing briefly between words to allow Kurzweil VoicePad to 

recognize what you are saying.
5 To make changes use:

For correcting the computer's mistakes:    The take- and correct-that commands to 
correct anything that Kurzweil VoicePad misrecognizes.
For editing when you change your mind:    The delete-that command or your mouse or 
keyboard to rewrite your text.

See Also
Controlling the Microphone 
Speaking So Kurzweil VoicePad Can Understand You
Understanding What You Can Say 
Overview of Correcting and Editing



    Overview of Correcting and Editing
Two kinds of changes
As you dictate you will occasionally want to make changes for two reasons:

Correcting:    Kurzweil VoicePad misrecognized what you said and inserted either 
the wrong word or nothing.
Editing:    You change your mind about something you dictated.

Kurzweil VoicePad supplies commands for both kinds of changes, as follows.
For this kind of change: Use one of these commands:
Correcting
Fixing Kurzweil VoicePad 
Misrecognitions

take- commands
correct-that command
endings-of- commands

Editing
Rewriting Your Text delete-that command

Changing immediately or going back
You can change the word you last dictated, or you can return to an earlier point in your 
dictation to make a change.    
Go back as many as 20 words using the back-up- commands. Then move ahead using 
either the:

forward- commands
move-on command

To make changes outside of the 20-word back-up range, click here for more information

See Also
Changing the Way Kurzweil VoicePad Spells a Word 



Correcting and editing outside of the 20-word back-up range
To back up more than 20 words, use your keyboard or mouse to move the insertion point, 
and normal editing features to fix the text.    When you use the mouse or keyboard, 
Kurzweil VoicePad loses context.    To resume dictation, simply click in your document again 
and begin speaking.



    Correcting:    Fixing Kurzweil VoicePad Misrecognitions
Sometimes Kurzweil VoicePad misrecognizes you and hears a word you didn't say. When
this happens, refer to the Take window and use one of the Kurzweil VoicePad correction 
commands.    Doing so refines the information Kurzweil VoicePad stores in your voice 
profile and makes recognition even better in the future.    Say:

take- and the number of the alternative if the correct word appears in the Take 
window. For example, say take-2 to choose the second alternative. Kurzweil 
VoicePad swaps the word you choose for the word it heard.
correct-that if the correct alternative does not appear in the Take window.
endings-of- and the number of the alternative if you said a form of one of the 
words in the Take window.    For example say endings-of-best or endings-of-3 to 
see other forms of one of the displayed alternatives.

Note: If the Take window remains blank, you cannot use these commands 
because Kurzweil VoicePad has lost context.    Click in your document to use 
standard editing features to make corrections.

To display a procedure for using one of these correction commands
Choose one of the following topics:

Swapping an Alternative from the Take Window
Correcting When The Right Alternative Doesn't Appear
Displaying Different Endings for One of the Alternatives

To correct persistent misrecognitions
See Using the Recognition Wizard.
To edit your dictation
See Editing:    Rewriting Your Text.



    Swapping an Alternative from the Take Window 
Follow these steps to swap an alternative from the Take window.    You can do this either
as soon as a misrecognition occurs, or you can go back to make the correction.
1 Say open-take to display the Take window if it is not already visible.
2 Say take- and the number of the alternative that you want to select. For example, to 

select the third alternative from the window, say take-3.
Kurzweil VoicePad replaces the word it misrecognized with the word you selected, or 
performs the action of the command.

Note:    If you did not say the word, do not take it from the Take window. 
Instead say delete-that and then say the word you want. See Editing:    
Rewriting Your Text.

See Also
Correcting When the Right Alternative Doesn't Appear
Using the Endings-Of Command 



    Correcting When the Right Alternative Doesn't Appear    
Follow these steps to correct a word when the Take window does not display the word 
you said as an alternative. You can do this either as soon as a misrecognition occurs, or 
you can go back to make the correction.

1 Say correct-that. The Correct That window appears.
2 In the Take Keys text box, begin typing the word you said or spelling it by voice 

alphabet. As you enter the letters, new alternatives appear that match the letters you
type. 

3 Do one of the following. If the word:
Appears in the Take-Best position, say take-best.
Appears as a numbered choice, say take- and the number. For example, say take-3 
as one phrase.
Does not appear as a choice, but you have spelled it completely in the Take Keys 
text box, say take-keys.    Doing so will add this new word to your free text 
vocabulary.
Does not appear as a choice and is a command, it is not an active command in 
your context. Exit from the Correct That window and verify the command using the 
Active Words window.
Does not appear as a choice but a form of the word does appear, use the endings-
of- command.

See Also
Swapping an Alternative from the Take Window
Using the Endings-Of Command
Editing:    Rewriting Your Text



 Using the Endings-Of- Command
Use the endings-of- command to display additional forms of a word from the Take 
window or the Correct That window.    You can choose a word from the resulting list and 
insert it in your document. Use this command only when Kurzweil VoicePad 
misrecognizes a word and does not display the correct form of the word in the Take 
window.
You can do this either as soon as a misrecognition occurs, or you can go back to make 
the correction.
Click here to display an example 
To use the endings-of command
1 Say endings-of-best or endings-of- and the number of the alternative. In the example 

above, say endings-of-1 to see different endings of "containing."    The Correct That 
window appears displaying forms of the root word.

2 If the word you said appears, take the word using the take- command.    In the 
example, say take-4 to take "containers." 

3 If the exact word does not yet appear, do one of the following:
Use take- to take the word that is closest; then modify it using your mouse or 
keyboard.
Say the endings-of- command again to display additional forms of the specified 
word; then use the take- command.

See Also
Correcting:    Fixing Kurzweil VoicePad Misrecognitions 



    Editing:    Rewriting Your Text
Editing your document by voice differs from correcting misrecognitions by voice. When 
you rewrite or edit, you are changing entries that Kurzweil VoicePad recognized 
correctly. Instead of using the correction commands, you should use the delete-that 
command or edit the text with your mouse or keyboard.    Simply select a word or 
passage and dictate new words to replace it.

Note: If you edit using your mouse or keyboard, Kurzweil VoicePad loses 
context.    To resume dictation, simply click in your document and begin 
speaking.

You can edit text immediately after you dictate a word, or you can go back to make the 
edit.
To view a demonstration
See Learning with the Kurzweil VoicePad Demo and Practice for a demonstration of 
dictation basics.

See Also
Examples of Rewriting Your Text  
Word Processor Cursor Movement Commands
Word Processor Text Selection Commands
Navigation Key Commands
Correcting:    Fixing Kurzweil VoicePad Misrecognitions 



correction commands
Use the following commands to correct Kurzweil VoicePad misrecognitions:

take-
correct-that
endings-of-



    Phrasing Numbers    
Kurzweil VoicePad lets you dictate any number easily by speaking the digits 0 through 9
continuously; that is, without pausing between digits or delimiters within the number.
To dictate 23, say two-three as one phrase without pausing.    To dictate 23.1, say two-
three-point-one.
.
Example Say

10 one-zero or one-oh
75 seven-five

100 one-zero-zero or one-oh-oh
347 three-four-seven

1998 one-nine-nine-eight
2001 two-oh-oh-one

2,856 two-comma-eight-five-six
1-800-380-1234 one-dash-eight-oh-oh-dash-three-

eight-oh-dash-one-two-three-four
3.14 three-point-one-four

$95.82 dollar-sign (pause) nine-five-point-
eight-two

1st, 2nd ... 
10th, ... 31st

first, second, ... 
tenth, ... thirty-first

1/2, 2/3, 1/4 one-half, two-thirds, one-fourth

To make corrections
If any digit in a number is misrecognized, you cannot use the back-up- command or click 
within the number to correct a single digit.    Instead you can delete the entire number and 
dictate again, or edit using your keyboard.

See Also
Dictating Number Words Discretely 
Examples of Phrasing Numbers 
Speaking So Kurzweil VoicePad Can Understand You



    Dictating Number Words Discretely    
You can dictate numbers as you dictate text, saying number words and briefly pausing 
after each.
Compared with dictating digits
Dictating number words can sometimes feel more natural, but recognition accuracy is 
better when you dictate digits because Kurzweil VoicePad needs to recognize fewer words 
(digits from 0 through 9 and delimiters).    You also have less to remember about acceptable
phrasing variations when you dictate digits. 

Number
Dictated as discrete 
number words Dictated as digits

12 twelve one-two
23 twenty-three two-three
1223 twelve (pause) twenty-

three
one-two-two-three

350 three-fifty three-five-oh
1000 one-thousand one-oh-oh-oh
2,000 two (pause) numeric-

comma (pause) thousand
two-comma-oh-oh-
oh

1.07 one (pause) point-oh 
(pause) seven
one (pause) decimal-point 
(pause) oh (pause) seven

one-point-oh-seven

$6.06 dollar-sign (pause) six 
(pause) point-oh (pause) 
six
dollar-sign (pause) six 
(pause) decimal-point 
(pause) oh (pause) six

dollar-sign (pause) 
six-point-oh-six

12-31-96 twelve (pause) dash 
(pause) thirty-one (pause) 
dash (pause) ninety-six

one-two-dash-three-
one-dash-nine-six

1900 ...
1996 ...
2009

nineteen-hundred
nineteen-ninety-six
twenty-oh-nine

one-nine-oh-oh
one-nine-nine-six
two-oh-oh-nine

1/2, 2/3, 
1/4...

one-half, two-thirds, one-
fourth

same

1st, 2nd, ... 
10th, ... 
31st

first, second, ... tenth, ... 
thirty-first

same

For more information about dictating digits, see Phrasing Numbers.
Spacing Guidelines 
Kurzweil VoicePad uses different spacing rules when you dictate numbers.

Inserting a Comma in a Sequence of Numbers
Say numeric-comma to insert a comma within a series of digits; this command 



does not insert a space after the comma. Say comma when you want to insert a 
comma and a space after a number. To dictate 10,000: say ten (pause) numeric-
comma (pause) thousand.
Dictating Decimal Point Numbers
Say point- and the digit to insert a decimal point. To dictate 5.5, say five (pause) 
point-five. You can also say five (pause) decimal-point (pause) five. Kurzweil 
VoicePad does not insert a space when you say this command.
Dictating Dollars
Say dollar-sign to insert the dollar sign ($) character in your document. Dictate 
the dollar value following the rules for whole numbers. Dictate the decimal value 
by following the rules for decimal point numbers.

See Also
Examples of Phrasing Numbers 



    Punctuating, Capitalizing, and Spacing Text    
Choose one of the topics below to display information on how to perform these tasks by
voice.

Punctuating Text 
Capitalizing Text 
Spacing Text 



    Punctuating Text    
You can insert punctuation in your document by saying the appropriate name of the 
punctuation. For example, to insert a colon, say colon; to insert a period, say period.
When you insert end punctuation, Kurzweil VoicePad automatically inserts spaces if 
auto-spacing is on, and automatically capitalizes the next word if the auto-cap is on.

Note:    See Phrasing Numbers for information on dictating punctuation with 
numbers.

Punctuatio
n

Say

. period or point or decimal-point

? question-mark

! exclamation-point

, comma or numeric-comma

; semi-colon

: colon

'
'      '

apostrophe, single-quote,
open-single-quote, close-single-quote

"      " open-quote close-quote

(      ) open-paren close-paren

[      ] open-bracket      close-
bracket

{      } open-curley      close-curley

<      
>

open-angle      close-angle

- hyphen or dash

-- long-dash

_ underbar

= equal-sign

+ plus-sign

@ at-sign

# number-sign

$ dollar-sign

% percent

^ caret

& ampersand

* asterisk



/ slash

\ backslash

| vertical-bar

` backquote

~ tilde

See Also
Pressing Keys by Voice
Kurzweil VoicePad Dictation Commands 
Spacing Text 
Capitalizing Text 
Examples of Inserting Punctuation by Voice 



    Capitalizing Text
By default, Kurzweil VoicePad automatically capitalizes the first word in a new sentence 
when you insert end punctuation in the previous sentence. 
If you want to override this setting, you can:

Use capitalization commands to change the current word or words you then 
dictate.
Change settings on the Capitalization tab of the Options dialog for all words you 
dictate.

To change the capitalization of the current word

To Say
Capitalize the first letter initial-cap-that 
Capitalize all the letters uppercase-that 
Lowercase all letters lowercase-that

Note:    If the Take window remains blank, Kurzweil VoicePad has lost context.  
Because there is no current word, you cannot use these commands.    Use 
editing features with your keyboard or mouse to change capitalization.

To capitalize a letter as you spell with the voice alphabet
Say capital- and the voice alphabet word as one phrase. For example, say capital-alpha.
To change capitalization settings before you dictate
Before you type, say a Kurzweil VoicePad capitalization command to override settings on 
the Options dialog, Capitalization tab.
To Say
Capitalize the first letter of each word 
you dictate

initial-cap-on 

Turn off the initial capitalization 
feature

initial-cap-off 

Capitalize all letters in each word you 
dictate

uppercase-on

Turn off the uppercase feature uppercase-off 
Lowercase all letters in each word you
dictate

lowercase-on 

Turn off the lowercase feature lowercase-off 
Automatically capitalize the first word 
of every sentence you dictate

auto-cap-on

Turn off the automatic capitalization 
feature

auto-cap-off

To change the capitalization setting on the Kurzweil VoicePad Options dialog
See Setting Capitalization Options.

See Also
Kurzweil VoicePad Dictation Commands 
Spacing Text 



Punctuating Text 



    Spacing Text    
By default, Kurzweil VoicePad is set to automatically insert one space between words 
and two spaces between sentences. You can turn these settings off on the 
Capitalization tab of the Options dialog or you can add and delete spaces using voice 
commands. 

Tips: Spacing guidelines differ when you dictate numbers. Refer to Phrasing 
Numbers for more information.

To change the spacing of the current word

To Say
Add a space after the current word space-bar 
Add a space before the current word add-space 
Delete a space after the current word backspace-key
Delete a space before the current 
word

delete-space 

Note:    If the Take window remains blank, Kurzweil VoicePad has lost context.  
Because there is no current word, you cannot use these commands.    Use 
your keyboard to add a space.

To change the setting for automatic spacing between words 
Do one of the following:

Say auto-spacing-on or auto-spacing-off. 
Choose Auto-Spacing from the Capitalization tab on the Options dialog.

To change the spacing between sentences
Do one of the following:

Say two-spaces-between-sentences. 
Choose Two Spaces Between Sentences from the Capitalization tab in the Options 
dialog.

See Also
Pressing Keys by Voice
Kurzweil VoicePad Dictation Commands 
Phrasing Numbers 
Setting Capitalization and Spacing Options



    Adding a Free Text Word That Is Unknown to Kurzweil 
VoicePad    

If you suspect a word is not part of the Kurzweil VoicePad free text vocabulary, dictate it
anyway.    Kurzweil VoicePad will attempt to match what you say with a free text word 
and will usually provide alternatives in the Take window.    
If the word does not appear, say correct-that and either choose an alternative from the 
Correct That window, or type the word in the Take Keys box. For the full procedure, see 
Correcting When The Right Alternative Doesn't Appear.

Note:    Occasionally, when the Take window remains blank, you are unable to
use correct-that.    In that event, you can add a word to the Free Text list by 
following the steps in the procedure for Adding a Word to the Free Text List. 



    Adding a Word to the Free Text List
When you can't use correct-that to add a free text word, follow these steps to add the 
word using the Active Words window.
To add a word to the Free Text list
1 Say open-active-words or click on the Active Words window.
2 Highlight any word in the Free Text list.

Tip:    To scroll quickly to the Free Text list, type or use the voice alphabet to 
spell a word that is not in any other command list.    For example, type your 
name.

3 Choose Add from the Edit menu or from the pop-up menu.    The Add Word dialog 
appears.

4 Type or use the voice alphabet to spell the new word as you want it to appear in your 
document when you dictate.    Use lowercase except for proper names.

5 Choose OK.    The Training dialog appears.
6 Follow the prompts to record speech samples of the new word and exit training.



     Controlling the Menus    
There are two ways you can control menus by voice:

"Say What You See" Method
Since commands follow the rule of "say what you see," the first place to look is the 
menus. To display the file menu, say file-menu.    Then "say what you see" to select 
an option from that menu.    For example, say file-menu (pause) open.

Shortcut Commands Method
Kurzweil VoicePad also provides shortcut commands that combine the menu and 
option as one command phrase. These commands correspond to the options that 
have shortcut keys on a menu.    For example, you can say file-open instead of file-
menu (pause) open.

To "say what you see"
1 Say the menu name and menu as one phrase. For example, say edit-menu. Be sure 

the Kurzweil VoicePad dictation window is active.
2 Say the name of the option you want to select. For example, say cut.

Tip:    Say escape-key or press ESC to back out of a menu.

To use a shortcut command
Say the shortcut command as one phrase. For example say file-open.
Kurzweil VoicePad Dictation Commands 
Spelling by Voice 
Punctuating Text
Phrasing Numbers 



    Pressing Keys by Voice
You can press any of the keys on a keyboard by saying a voice command. Click on a key
in the graphic below to display the corresponding command.

Tip:    In dictation you can use the Keyboard window to spell by voice or to 
press an extended key or key sequence such as CTRL + S.

See Also
Kurzweil VoicePad Dictation Commands 
Spelling by Voice 
Punctuating Text
Phrasing Numbers 



    Kurzweil VoicePad Dictation Commands    
Listed below are the commands you can say to control Kurzweil VoicePad as you 
dictate. See Finding What You Can Say for information on finding a specific command in 
the Active Words window.

Note:    If the Take window remains blank, Kurzweil VoicePad has lost context, 
and you cannot use any commands that act on the current word. Click in your 
document and resume dictation.

Say To 
add-space Add a space before the current word
auto-cap-off Turn off automatic capitalization
auto-cap-on Automatically capitalize the first word of every sentence
auto-spacing-off Turn off automatic spacing; add spaces manually
auto-spacing-on Automatically insert one space between words and two spaces 

between sentences
backspace-key Delete the character to the left of the cursor
back-up-1, 2, 3, 4 Back up one to four words from the current word
close-active-
words

Close the Active Words window

close-take Close the Take window
correct-that Display the Correct That window to correct a word that Kurzweil 

VoicePad misrecognized
delete-space Delete a space before the current word
delete-that Delete the current word
endings-of-best Display alternative endings of the current word
endings-of-1, 2, 
3, 4

Display the endings of the first through fourth alternative

forward-1, 2, 3, 4 Move forward one to four words from the current word after using 
back-up-

initial-cap-off Turn off the initial capitalization feature
initial-cap-on Capitalize the first letter of each word you dictate
initial-cap-that Capitalize first letter of the current word
listen-to-me Turn on the microphone (available only after you have used stop-

listening to turn the microphone off)
lowercase-off Turn off the lowercase text option 
lowercase-on Insert words in all lowercase letters
lowercase-that Change current word to all lowercase letters
move-on Return the insertion point to the position it occupied before you 

used the back-up command
open-active-
words

Open the Active Words window

open-keyboard Open the Keyboard window
open-take Open the Take window
recognition- Display the Recognition Wizard



wizard
save-profile Save your voice profile
sound-levels Check background and voice levels
space-bar Add a space after the current word
stop-listening Turn off the microphone 
take-1, 2, 3, 4 Take first to fourth alternative from Take window or Correct That 

window
uppercase-off Turn off the uppercase text option
uppercase-on Insert words in all uppercase letters
uppercase-that Change current word to all uppercase letters

See Also
Using the Active Words Window 



    Navigating in and Controlling Windows and Dialog Boxes    
You can use Kurzweil VoicePad to navigate in and control your document and dialog 
boxes. Choose a topic below to display a list of voice commands.

Navigating in a Document
Controlling the Document Window 
Navigating in and Controlling Dialog Boxes 
Navigating in the Kurzweil VoicePad Window 

See Also
Kurzweil VoicePad Dictation Commands 
Using the Active Words Window 
Finding What You Can Say



    Navigating in a Document
Say the commands listed below to navigate within your document. 

To move to the Say
Previous location before 
you used the back-up 
command

move-on

Beginning of document beginning-of-document
End of document end-of-document
Next line next-line
Previous line previous-line
Next screen or page next-screen, page-

down
Previous screen or page previous-screen, page-

up

To press Say
 Down Arrow down-arrow
Up Arrow up-arrow
Left Arrow left-arrow
Right Arrow right-arrow
End end-key
Home home-key
Page Down page-down
Page Up page-up
Tab tab-key
Spacebar space-bar
Backspace backspace-key

You can easily add your own navigation commands using the Active Words window. See
Adding a Command for more information.

See Also
Using the Active Words Window 
Finding What You Can Say
Navigating in the Kurzweil VoicePad Window



    Navigating in the Kurzweil VoicePad Window    
Say the commands listed below to navigate within and control the Kurzweil VoicePad 
window. 
To Say
Display a menu [menu name]-menu
Display online Help contents help-menu (pause) contents
Display the control menu control-menu
Maximize the    size of the Kurzweil 
VoicePad window

maximize-application

Minimize the Kurzweil VoicePad 
window to an icon

minimize-application

Restore the Kurzweil VoicePad 
window to previous size

restore-application

Move the Kurzweil VoicePad window move-application, and then 
use arrow-key commands to 
specify the direction and 
distance to move.    See the 
procedure below.

Close Kurzweil VoicePad close-application

To move the Kurzweil VoicePad window
1 Make the window that you want to move active.
2 Say move-application. This command selects the window.
3 Say the arrow-key command to move the window one step in the respective direction.    

For example, say up-arrow to move the document window up one step.
4 When the window is in the location you want, say enter-key to unselect the window.



    Navigating in and Controlling Dialog Boxes
In general you can "say what you see" to use features of a dialog box.    To move focus, 
select options, or invoke actions, say the names of tabs, text boxes, check boxes, option
buttons, command buttons, lists, and so forth.
To confirm what you can say, watch the commands listed in the Active Words window as
you work.

Important: Kurzweil VoicePad does not recognize untrained commands, 
which are marked by red diamonds ( ) in the Active Words window.    If you 
see many red diamonds, you can save training time by Using Command 
Learning.

To select a tab
Say the tab name.    For example, to display the Microphone tab in the Kurzweil VoicePad 
Options dialog, say microphone.
To press a button
Say the button name.    For example, to press the Defaults button on the Microphone tab, 
say defaults. 
To move the insertion point in the dialog box
Do one of the following:

Say the label name.    For example, to move the insertion point to the File Type text
box in the Open dialog, say file-type as one phrase. 
Say tab-key to move through the dialog box's tab sequence.

To use drop-down lists
1 Say the label name to move the insertion point to the list and display it.    For 

example, say drives to move the insertion point to the Drives list.
2 To highlight an option, say down-arrow or up-arrow.
3 To make your selection and close the list, say enter-key.

To enter text into a text box
1 Say the label name to move the insertion point to the text box.
2 Spell the word using the voice alphabet.

To select or unselect an option button or check box
Say the option name. For example, to select or unselect the Lowercase On option on the 
Capitalization tab, say lowercase-on.
To accelerate a dialog action that you perform frequently
You can create your own command to combine several steps you perform in a dialog box.    
For example, to create bold blue text you can create a command called bold-blue .    You 
can place the command in the Kurzweil VoicePad Command list if you want to use it in 
dictation without making other changes, such as the style or size of the text.    Such a 
command could open the Format menu, choose the Font option, make the Bold and Blue 
selections on the Font dialog, and press OK.
If you want to perform the bold-blue command on the Font dialog in your word 
processor, however, you can place it in the Font dialog command list so it will be 
available when the Font dialog is open.    Doing so lets you manipulate other controls in 
the Font dialog to make other changes, and then say bold-blue to display the Color 



drop-down list and select Blue from the list.

See Also
Finding What You Can Say 
Spelling By Voice 



    Using the Kurzweil VoicePad Main Window
Use the Kurzweil VoicePad main to verify whether Kurzweil VoicePad is listening and 
what it last heard.

See Also 
Opening and Closing Kurzweil VoicePad Windows 
Understanding the Kurzweil VoicePad Windows 



    Using the Take Window
Use the take- command to swap a word from the Take window when Kurzweil VoicePad 
misrecognizes the word you said. The Take window displays the word that Kurzweil 
VoicePad heard, known as the current word, and as many as four alternative words. 
Always display the Take window when you are using Kurzweil VoicePad; if you don't, you
won't know whether the word you said was one of the alternatives.

Note: Do not use delete-that to correct a misrecognized word.    Only when 
you use take- or correct-that can Kurzweil VoicePad adapt to improve 
recognition accuracy.

To open or close the Take window
Say open-take or close-take.

- or -
1 With the Kurzweil VoicePad main window active, say VoicePad-menu (pause) options or 

choose Options from the menu.
2 Choose the Preferences tab.
3 Select or unselect the Open Take option.
4 Choose OK to activate the new setting and close the Options dialog.

To choose a displayed alternative
Do one of the following:

Say take- and the number of the alternative.    For example, say take-1.
Double-click on the alternative word.

In the window above, the top line shows that Kurzweil VoicePad heard the word see. But
you said the word seat. To correct this misrecognition, you would say take-4 and 
Kurzweil VoicePad would swap seat for see.

Note:    If the Take window remains blank, Kurzweil VoicePad has lost context 
and you cannot use commands like take-, correct-that, delete-that, and move-
on. Click in your document and begin dictating again.

To display different forms of a displayed word
See Using the Endings-Of- Command.

To correct a word when the alternatives don't help
If the Take window does not display an alternative you can use, say correct-that to make 
the change.    For information see Correcting:    Fixing Kurzweil VoicePad Misrecognitions.
To learn more about how this window works
Click on a part of the graphic to display more information.

See Also
Opening and Closing Kurzweil VoicePad Windows  
Understanding the Kurzweil VoicePad Windows



    Using the Keyboard Window      
Hands-Free Help
Use the Keyboard window to do the following as you dictate:

Spell using the voice alphabet
To insert the company acronym KAI, say capital-kilo (pause) capital-alpha (pause) 
capital-india.
Press extended keys
To press the ALT + V keys simultaneously, say alt-victor.

To learn more about the Keyboard window
To display a picture with details 
1 Say tab-key to put focus on the jump text above.
2 Say enter-key to activate the jump and display the picture.

To use the Keyboard window
1 Say open-keyboard. to display the Keyboard window.
2 Spell the word using the voice alphabet or say the commands that correspond to the 

key or keys you want to press. See Pressing Keys by Voice    for the key commands.

Tip: The Keyboard window does not automatically insert a space before a 
word. To insert a space before the word, say space-bar before you begin 
spelling.

3 When you finish, do one of the following.
Say insert to insert your entry and use the Voice Keyboard again.
Say insert-close to insert the entry and close the dialog box.

To display the voice alphabet cue card
To see the voice alphabet cue card as you speak to this window, follow these steps:
1 With the Keyboard window active, say voice-alphabet-cue-card.
2 To switch focus to the Keyboard window so you can speak to it, say open-keyboard.
3 If you need to move the Keyboard window so you can see it, say move-window and an 

arrow-key command to indicate direction.
4 When you have moved the window far enough, say enter-key.

See Also
Example of Using the Keyboard Window



    Using the Active Words Window
The Active Words window displays the commands that you can say and words you can 
dictate in your current location.    This set of active commands changes as you move 
between dictating in a document, using menus, and using dialog boxes.

Note: A red diamond ( ) indicates that you need to train the marked 
command or word.    Kurzweil VoicePad cannot recognize an untrained 
command.

Command lists
Commands in this window are grouped into command lists, such as the Navigation Keys list
shown here.    The Free Text list also appears in the Active Words list if it is valid for your 
current location.    Say page-up and page-down  or use the scroll bar to scroll through the 
lists.
To find a command in the Active Words window
See Finding What You Can Say.
To learn about the menus on this window
You can use the Edit, Train, or pop-up menus on this window to train, add, delete, edit, find,
or "say" commands.    For more information, see Active Words Window Menus.
To open or close the Active Words window
Say open-active-words or close-active-words. 
- or -
1 With the Kurzweil VoicePad main window active, say VoicePad-menu (pause) options or 

choose Options from the menu.
2 Choose the Preferences tab.
3 Select or unselect the Open Active Words option.
4 Choose OK to activate the new setting and close the Options dialog.

To put voice focus in the Active Words window
Say open-active-words or click on the Active Words window.

See Also
Understanding Command Lists
Adding a Command
Deleting a Command
Editing a Command 
Training Commands or Words to Improve Recognition
Voice-Enabling a New Application 



    Using the Add/Edit Command Dialog
Choose a topic below to display more information on the task you want to perform.

Adding a Command 
Editing a Command 



    Using the Menu Command Training Dialog
Click here to see a picture with details 
Use the Menu Command Training dialog to record speech samples of menu commands.  
Training these commands is one way to improve recognition by helping Kurzweil 
VoicePad adapt to your speaking style.
To display the Menu Command Training dialog
1 Say open-active-words or click on the Active Words window to display it.
2 Choose Menu Commands from the Train menu.

To train a selected menu command
1 Highlight a command in the Words to Train list.
2 Choose the Selected button.

To train all menu commands
Choose the All Words button.

To train only the untrained ( ) menu commands
Choose the Untrained button.



    Using the VOICE Command Training Dialog    
Click here to see a picture with details 
Use the VOICE Command Training dialog to record speech samples of commands for 
Kurzweil VoicePad windows and dialogs.    Training these commands is one way to 
improve recognition by helping Kurzweil VoicePad adapt to your speaking style.
To display the VOICE Command Training dialog
1 Say open-active-words or click on the Active Words window to display it.
2 Choose VOICE Commands from the Train menu.

To train a selected command in the list
1 Highlight a command in the Words to Train list.
2 Choose the Selected button.

To train all commands in the list
Choose the All Words button.



    Setting Kurzweil VoicePad Options
Use the following tabs on the Options dialog to tailor your Kurzweil VoicePad 
environment:

Capitalization
Set capitalization and spacing options
Microphone
Set microphone gain inside Kurzweil VoicePad
Preferences 
Set desktop, hands-free, and profile saving options
Recognition
Set recognition and tuning options

To access an Options tab
1 With the Kurzweil VoicePad main window active, say VoicePad-menu (pause) options or 

choose Options from the menu.
2 Choose a tab by any of the following methods.

Say the tab name. For example, say microphone.
Click on the tab using the mouse.

See Also
Using the Kurzweil VoicePad Main Window 
Kurzweil VoicePad Menu 



    Using the Recognition Wizard
Click here to see a picture with details 
The Recognition Wizard guides you through recognition tuning to solve persistent 
recognition problems.    When you select a problem from the list, the Recognition Wizard
leads you through corrective actions, such as adjusting the microphone sensitivity or 
training a word that Kurzweil VoicePad consistently misrecognizes.
To open the Recognition Wizard 
Say recognition-wizard    or choose Recognition Wizard from the Kurzweil VoicePad menu.
To display guidelines for using Kurzweil VoicePad
Say read-me or choose the Read Me button to verify that you are following usage 
guidelines. Following the guidelines may correct the problem or ensure that the action you 
take with the Wizard is effective.    If the problem persists, return to the Recognition Wizard.
To use the Recognition Wizard
1 Select a problem from the list.
2 Choose the Solve button. 
3 Follow the prompts as directed.    Choose Help from any Solution dialog for more 

information.

Tip:    Some problems may have more than one solution. The phrase 
'Solutions (1 of x)' indicates multiple solutions. 

See Also
Helping Kurzweil VoicePad Adapt to Your Speaking Style 



    Help on Solving Problems With the Recognition Wizard
Choose the name of the problem from the list below to display Help on solving it with 
the Recognition Wizard.

Doesn't Recognize Your Word 
Deaf on One Word
One Word Intrudes No Matter What You Say 



    Help on Solving Problems With the Recognition Wizard
Choose the name of the problem from the list below to display Help on solving it with 
the Recognition Wizard. 

Hears a Noise as a Word 
Hears You When You Are Not Speaking 
Occasionally Does Not Hear You 
Does Not Hear Anything You Say 
The Status Line Says 'Too Loud' 
The Status Line Says 'Too Long' 
Generally Poor Recognition 
Help on Does Not Hear Me Correctly When I Say Numbers 
Reset All Values to Default Values 



    Help on Confuses a Pair of Words
Select the two words from the list that Kurzweil VoicePad confuses and train them.
To solve this problem
1 In the Word Said text box, enter the word that you said but Kurzweil VoicePad doesn't

recognize.    Use the keyboard or the voice alphabet. When the word appears, select 
it. 

Note:    If the word does not appear in this list, it is not trained. To correct this 
problem, exit from the Wizard and train the word or command using the 
Active Words window.

2 In the Word Heard text box, enter the word that Kurzweil VoicePad hears.    Use the 
keyboard or the voice alphabet. When the word appears, select it. 

3 Choose the Solve button. The Train Word dialog box appears.
4 Follow the prompts to train both words. If you need help, choose the Help button from

this dialog box.



    Help on Sound Levels and Training    
Choose one of the topics from the list below to display more information on the task 
you want to perform.
Checking Sound Levels 
Training Words 
Training a Noise 



    Adjusting Microphone Gain
Lower the gain if you frequently see the message 'Too Loud' in the Kurzweil VoicePad 
main window. This occurs if you are using Kurzweil VoicePad in a noisy environment or 
you normally speak loudly. 

Note:    If you lower the gain and then frequently see the message 'Word not 
recognized' in the Kurzweil VoicePad main window, reset the gain to its default
value. 

To adjust the microphone gain
Click the left or right arrow button to move the slider and change the Microphone gain 
value.



    Using the Current User Dialog    
The Current User dialog displays information about the voice profile you are currently 
using.    Use this dialog to:

Confirm that you are using your own voice profile
Correct the profile gender if it has been specified incorrectly (the wrong gender 
causes poor recognition)
Check the number of words you have spoken and/or trained

User Information Description
Name User's name
Gender Voice profile gender (or Child 

setting) 
Words Trained Total number of words the user 

has trained
Words Spoken Total number of words the user 

has spoken to Kurzweil 
VoicePad.

To change the voice profile gender
Do one of the following:

Select your correct gender. 
Select Child for a young user. Generally, this setting is appropriate for an 
adolescent whose voice has not reached full maturity.



 Adding a Voice Profile for a New User    
New users of Kurzweil VoicePad need to create a voice profile.    Information is stored in 
your voice profile that helps Kurzweil VoicePad recognize you when you speak.
To create a voice profile
1 Type your name in the text box.
2 Do one of the following.

Select your gender by clicking on the correct option button.
Select Child for an adolescent whose voice has not reached full maturity.

Note:    Selecting the wrong gender will result in poor recognition.

3 Choose OK. The Start User dialog appears with the new user name highlighted.

See Also
Selecting a Voice Profile 
Saving Your Voice Profile 



    Using the Start User Dialog    
The Start User dialog lets you select, add, or delete a user's voice profile.

Important:    You should always use your own voice profile; doing so helps 
Kurzweil VoicePad recognize you when you speak. In addition, Kurzweil 
VoicePad adapts to your speaking style as you work, so you should never use 
someone else's profile and risk corrupting that person's voice profile data with
your own speech.

See Also
Creating a Voice Profile 
Selecting a Voice Profile 
Deleting a Voice Profile 
Loading a Default Voice Profile at Start Up 



    Using the Add Word Dialog
Use the Add Word dialog to add a word to your free text vocabulary.    When you have 
added this word you must train (record speech samples of) it before you can use it in 
dictation.    
To add a new word
1 Type or use the voice alphabet to spell the word into the Word is spelled box.
2 Choose OK.    The new word appears in the Active Words window, marked by a red 

diamond ( ).

To train the new word
1 Select the word from the Active Words window and choose Selected from the Train menu 

or Train from the pop-up menu.
2 Follow the prompts to record speech samples.



    Opening Command Cue Cards
Cue cards are available globally to help you remember commands.    You can open any 
of the following cue cards by:

Saying the corresponding command, listed below
Choosing the cue card from the Kurzweil VoicePad Help menu

Note:    Unlike the Active Words window, cue cards are static and do not 
reflect your current location.

To display the cue card now, click the green link text.
To show this cue 
card

Say

Basic Commands basic-commands-cue-
card

Alphabet voice-alphabet-cue-card
Navigation navigation-cue-card
Punctuation punctuation-cue-card
Numbers numbers-cue-card

To show these cue 
cards Say
Word Processor 
Cursor Movement
Word ProcessorText 
Selection

either:
basic-commands-cue-
card
navigation-cue-card
and then click the green
hyperlink to the 
appropriate cue card.



Voice Alphabet 

a alpha j juliet s sierra
b bravo k kilo t tango
c charlie l lima u uniform
d delta m mike v victor
e echo n november w whiskey
f foxtrot o oscar x x-ray
g golf p papa y yankee
h hotel q quebec z zulu
i india r romeo

To capitalize a letter, say capital- before the code name.    For example, say capital-alpha to insert a 
capital A.

Note:    You must return focus to either the Keyboard window or a dialog box to use 
these commands.

See Spelling By Voice for more information.



Basic Kurzweil VoicePad 
Commands

take-1 (2, 3, 4)

correct-that
take-keys
take-best

endings-of-best (1, 2, 3, 
4)

delete-that

back-up-1 (2, 3, 4)
move-on
forward-1 (2, 3, 4)

add-space
delete-space

initial-cap-that
initial-caps-on 
(off)
uppercase-that

open-active-
words
open-keyboard
open-mouse
open-take

sound-levels
recognition-
wizard

stop-listening

Note:    You must return focus to the Kurzweil VoicePad dictation window to use these 
commands.

For a complete list of commands, see Kurzweil VoicePad Commands.
See Also
Word Processor Cursor Movement Commands 
Word Processor Text Selection Commands 
Punctuation Commands 



Navigation Commands

enter-key backspace-key
space-bar delete-key
tab-key insert-key
escape-key up-arrow
home-key down-arrow
end-key left-arrow
page-up right-arrow
page-down

Note:    You must return focus to the Kurzweil VoicePad dictation window to use these 
commands.

See Also
Word Processor Cursor Movement Commands 
Word Processor Text Selection Commands 
Punctuation Commands 



Punctuation Commands
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<
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comma
period
question-mark
exclamation-point

dot-dot-dot
semi-colon
colon

open-quote
close-quote

apostrophe
single-quote
open-single-quote
close-single-quote

open-paren
close-paren
open-curley
close-curley
open-bracket
close-bracket
open-angle
close-angle

~
@
#
$
%
^
&
*

-
_
+
=

|
\
/

,
.
-

tilde
at-sign
number-sign
dollar-sign
percent-sign
caret
ampersand
asterisk

hyphen
underbar
plus-sign
equal-sign

vertical-bar
backslash
slash

For dictating 
numbers:
numeric-comma
decimal-point
minus-sign

Note:    You must return focus to the Kurzweil VoicePad dictation window to use these 
commands.

For a keyboard picture with links to these commands, see Pressing Keys by Voice.
If Kurzweil VoicePad does recognize not your punctuation commands, see Using the Recognition 
Wizard.



Number Dictation Commands

Example Say
10 one-zero or one-oh
75 seven-five

100 one-zero-zero or one-oh-oh
347 three-four-seven

1998 one-nine-nine-eight
2001 two-oh-oh-one

2,856 two-comma-eight-five-six
1-800-380-1234 one-dash-eight-oh-oh-dash-three-

eight-oh-dash-one-two-three-four
3.14 three-point-one-four

$95.82 dollar-sign (pause) nine-five-point-
eight-two

1st, 2nd ... 
10th, ... 31st

first, second, ... 
tenth, ... thirty-first

1/2, 2/3, 1/4 one-half, two-thirds, one-fourth

Note:    You must return focus to the Kurzweil VoicePad dictation window to use these 
commands.

See Also
Dictating Numbers Discretely



Voice Alphabet

a alpha j juliet s sierra
b bravo k kilo t tango
c charlie l lima u uniform
d delta m mike v victor
e echo n november w whiskey
f foxtrot o oscar x x-ray
g golf p papa y yankee
h hotel q quebec z zulu
i india r romeo

To capitalize a letter, say capital- before the code name.    For example, say capital-alpha to insert a 
capital A.

Note:    You must return focus to either the Keyboard window or a dialog box to use 
these commands.

See Spelling By Voice for more information.



Basic Kurzweil VoicePad 
Commands

take-1 (2, 3, 4)

correct-that
take-keys
take-best

endings-of-best (1, 2, 3, 
4)

delete-that

back-up-1 (2, 3, 4)
move-on
forward-1 (2, 3, 4)

add-space
delete-space

initial-cap-that
initial-caps-on 
(off)
uppercase-that

open-active-
words
open-keyboard
open-take
open-mouse

sound-levels
recognition 
wizard

stop-listening

Note:    You must return focus to the Kurzweil VoicePad dictation window to use these 
commands.

For a complete list of commands, see Kurzweil VoicePad Commands.
See Also
Word Processor Cursor Movement Commands 
Word Processor Text Selection Commands 
Punctuation Commands 



Navigation Commands

enter-key backspace-key
space-bar delete-key
tab-key insert-key
escape-key up-arrow
home-key down-arrow
end-key left-arrow
page-up right-arrow
page-down

Note:    You must return focus to the Kurzweil VoicePad dictation window to use these 
commands.

See Also
Word Processor Cursor Movement Commands 
Word Processor Text Selection Commands 
Punctuation Commands 



Word Processor Cursor 
Movement Commands

next-word beginning-of-line
previous-word end-of-line
next-page beginning-of-paragraph
previous-page end-of-paragraph
next-sentence beginning-of-document
previous-sentence end-of-document

Note:    You must return focus to your word processor to use these commands.

See Also
Word Processor Text Selection Commands 
Basic Kurzweil VoicePad Commands 
Navigation Commands 



Word Processor Text 
Selection Commands

select-next-word select-next-paragraph
select-previous-word select-next-page
select-beginning-of-
line

select-beginning-of-document

select-end-of-line

Note:    You must return focus to your word processor to use these commands.

See Also
Word Processor Cursor Movement Commands 
Basic Kurzweil VoicePad Commands 
Navigation Commands 



Punctuation Commands
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)
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]
<
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comma
period
question-mark
exclamation-point

dot-dot-dot
semi-colon
colon

open-quote
close-quote

apostrophe
single-quote
open-single-quote
close-single-quote

open-paren
close-paren
open-curley
close-curley
open-bracket
close-bracket
open-angle
close-angle

~
@
#
$
%
^
&
*

-
_
+
=

|
\
/

,
.
-

tilde
at-sign
number-sign
dollar-sign
percent-sign
caret
ampersand
asterisk

hyphen
underbar
plus-sign
equal-sign

vertical-bar
backslash
slash

For dictating 
numbers:
numeric-comma
decimal-point
minus-sign

Note:    You must return focus to the Kurzweil VoicePad dictation window to use these 
commands.

For a keyboard picture with links to these commands, see Pressing Keys by Voice.
If Kurzweil VoicePad does recognize not your punctuation commands, see Using the Recognition 
Wizard.



Number Dictation Commands

Example Say
10 one-zero or one-oh
75 seven-five

100 one-zero-zero or one-oh-oh
347 three-four-seven

1998 one-nine-nine-eight
2001 two-oh-oh-one

2,856 two-comma-eight-five-six
1-800-380-1234 one-dash-eight-oh-oh-dash-three-

eight-oh-dash-one-two-three-four
3.14 three-point-one-four

$95.82 dollar-sign (pause) nine-five-point-
eight-two

1st, 2nd ... 
10th, ... 31st

first, second, ... 
tenth, ... thirty-first

1/2, 2/3, 1/4 one-half, two-thirds, one-fourth

Note:    You must return focus to the Kurzweil VoicePad dictation window to use these 
commands.

See Also
Dictating Numbers Discretely



    Examples of Using Kurzweil VoicePad    
Choose a topic name to display examples you can follow for practice.

Adding Commands 
Using the Voice Alphabet 
Rewriting Your Text 
Using the Keyboard Window 
Navigating in a Dialog Box 



    Examples of Adding a Command    
Choose one of the topics below to display the procedure for adding one of the following 
types of commands.

Adding an Editing Command
Adding a Command that Inserts Text



    Example of Adding an Editing Command
Just like the macro feature in other applications, Kurzweil VoicePad lets you create your 
own voice commands to help make your work easier. Follow the instruction below to 
create a voice command that moves the insertion point to the top of the document, 
selects all the text to the end of the document, and copies it. 
To create a select-and-copy command
1 Say open-active-words or click the Active Words window to make it active.
2 Say edit-menu (pause) add , or choose the Add from the Edit menu or pop-up menu. 

The Add Command dialog appears.
3 In the Word is spelled text box, enter select-copy either by keyboard or by voice 

alphabet.
4 In the Word is option, select 'a command.'
5 In the Define Action text box, press the following keys that perform the command 

action.
Ctrl + Home
Ctrl + Shift + End
Ctrl + C

Result: The following text appears in the Define Action box:
&{HOME}&+{END}&c 

Hands-Free Users: To enter extended keys in the Define Action box by voice, 
see Pressing Keys by Voice.    Each key sequence specified by voice can 
include no more than two simultaneous key presses.    In this example, you 
must enter Ctrl + Shift + End using your keyboard.

6 Select the Clears Alternatives check box since the command moves the insertion point.
7 Choose OK to save the new command and return to the Active Words window.

To train the new command
You must train each new command before you can use it.    See Training a Selected 
Command.



    Example of Adding a Command that Inserts Text 
Use the Active Words window to add a command that inserts text into your document. It
is important that you place the command in the correct command list. See 
Understanding Command Lists for more information.
To create a command that inserts text 
1 Click the Add Command button on the VoicePad toolbar.
2 In the Word is spelled text box, enter closing-paragraph either by keyboard or by 

voice alphabet.
3 In the Word is option, choose 'text' since the command inserts text and does not 

perform any other action.
4 In the Define Action text box, enter the following paragraph: 

Thank you for your interest in our product. Please call me at your earliest 
convenience to schedule an appointment. 

5 Choose OK to save the command and return to the Active Words window.

To train the new command
You must train each new command before you can use it.    See Training a Selected 
Command.



    Examples of Rewriting Your Text 
To delete the last word you dictated
In this example, swap the word paper for the word corner.
1 Dictate the phrase: initial-caps (pause) bring (pause) the (pause) paper 
2 Say delete-that. Kurzweil VoicePad deletes the word paper.
3 Say corner. Kurzweil VoicePad inserts the word corner.

Important:  If Kurzweil VoicePad misrecognizes you, say correct-that to fix 
the misrecognition.    Doing so helps sharpen your voice profile and lets 
Kurzweil VoicePad adapt to your speaking style.

To delete a word within the back-up range 
In this example, use the back-up and delete-that commands to change Bring to Fold in 
the following sentence.
1 Dictate: initial-caps (pause) bring (pause) the (pause) corner (pause) to (pause) the 

(pause) front (pause) period.

To move the cursor back to the end of the word Bring, say two back-up- commands:
2 Say back-up-4. (Remember the period counts as one word in Kurzweil VoicePad.) The 

insertion point moves to the end of the word corner.
3 Say back-up-2. The insertion point moves to the end of the word Bring.
4 Say delete-that. Kurzweil VoicePad deletes Bring.
5 Say initial-caps (pause) fold. 
6 Say move-on to move your cursor to the end of the sentence and resume your 

dictation.

See Also
Overview of Correcting and Editing
Correcting:    Fixing Kurzweil VoicePad Misrecognitions 
Editing:    Rewriting Your Text 



    Examples of Using the Voice Alphabet
The following examples represent circumstances when you can use the voice alphabet 
to spell your input.

Tip:    Say capital- and the voice alphabet word as one phrase to capitalize a 
letter. For example, to capitalize the letter a, say capital-alpha.

To add a new word to your free text vocabulary
1 As you dictate text, say Erica. If this is the first time that Kurzweil VoicePad heard this 

word, it will not recognize it.
2 Say correct-that to display the Correct That dialog.
3 Say capital-echo (pause) romeo (pause) india (pause) charlie (pause) alpha.

The corresponding letters appear in the Take Keys box as you speak.
4 Say take-keys to close the Correct That dialog and insert Erica into your dictated text.

Kurzweil VoicePad also adds Erica to your free text vocabulary and makes that word 
available for future dictation.

To insert a word not available in free text
1 Say open-keyboard to display the Keyboard window.
2 Spell the company acronym KAI by saying capital-kilo (pause) capital-alpha (pause) 

capital-india.
3 Say insert-close to insert the word into your dictation and close the Keyboard window.

To enter a word into a dialog text box
1 Say the name of the text box to give it focus, or say tab-key until focus moves to the text

box.
2 To spell the file name test.doc, say tango (pause) echo (pause) sierra (pause) tango 

(pause) period (pause) delta (pause) oscar (pause) charlie.

To press a key combination that includes a letter
1 Say open-keyboard to open the Keyboard window.
2 To press the ALT + V keys simultaneously, alt-victor.
3 Say insert to perform the key presses, opening Kurzweil VoicePad's View menu and 

leaving the Keyboard window displayed.
4 To press X, say x-ray.
5 Say insert-close to perform the key press to choose a View menu option and close the 

Keyboard window.



    Example of Using the Keyboard Window    
Use the Voice Keyboard to spell or to press keys simultaneously by voice in a dialog box
or document.
To press the Ctrl + End key sequence by voice
Follow the steps below to press these key using the Keyboard window.
1 Say open-keyboard. The Keyboard window appears.
2 Say control-end-key.
3 Say insert-close. Kurzweil VoicePad performs the command.

Tip: You might consider creating a voice command for any key sequence you 
use regularly. See Adding a Command.



    Example of Navigating in a Dialog Box    
Use the Open dialog box to follow these examples.
To move around the dialog box
Use one of the following methods:

Say tab-key or shift-tab-key.
Say the label name for a control such as a text box to go directory the control.

To select a drive 
1 Say drives or tab-key until the insertion point is located in the Drives option.
2 Say down-arrow to display the list.
3 Say up-arrow until drive a: is highlighted. 
4 Insert a diskette into drive a:.
5 Say enter-key to select that choice.

To select a directory
1 Say directories  or tab-key until the insertion point is located in the Directories 

option.
2 Say up-arrow and down-arrow until the Windows directory is highlighted.
3 Say enter-key to select that choice.

To enter the file name in the File Name text box
1 Say file-name or tab-key to move the cursor to the File Name text box if necessary.
2 Delete any text that appears in the box. Use the delete-key command.
4 Spell the file name SETUP.TXT, using the voice alphabet.

Say sierra (pause) echo (pause) tango (pause) uniform (pause) papa (pause) period 
(pause) tango (pause) x-ray (pause) tango.

5 Say OK to open the file.



    Examples of Phrasing Numbers 
Follow the examples below to practice speaking numbers. For more information, see 
Phrasing Numbers .
To speak numbers by saying digits continuously
To dictate a date
Example: April 15, 1996

Say april (pause) one-five-comma (pause) nineteen-ninety-six.
To dictate numbers with a decimal point
Example: 3.141592

Say three-point-one-four-one-five-nine-two.
To dictate a monetary value
Example $25.16

Say dollar-sign (pause) two-five-point-one-six.
To dictate whole numbers
Example: 53

Say five-three.
Example: 164

Say one-six-four.
Example: 1,004

Say one-comma-zero-zero-four.
or
Say one-comma-oh-oh-four.

Example: 2,000
Say two (pause) numeric-comma (pause) thousand. 

To dictate fractions
Click here to display the list of fraction commands you can speak.

To speak numbers discretely
To dictate a date
Example: April 15, 1994

Say april (pause) fifteen (pause) numeric-comma (pause) nineteen-ninety-four.
To dictate numbers with a decimal point
Example: 3.141592

Say three (pause) point-one (pause) four (pause) one (pause) five (pause) nine 
(pause) two.
or
Say three (pause) decimal-point (pause) one (pause) four (pause) one (pause) five 
(pause) nine (pause) two.

To dictate a monetary value
Example $25.16

Say dollar-sign (pause) twenty-five (pause) point-one (pause) six.
To dictate whole numbers



Example: 53
Say fifty-three.

Example: 164
Say one (pause) sixty-four.

Example: 1,004
Say one (pause) numeric-comma (pause) hundred (pause) four.

Example: 1,000,000
Say one (pause) numeric-comma (pause) thousand (pause) numeric-comma (pause) 
thousand.

Tip:  Say numeric-comma to insert a comma in a series of numbers; say 
comma when you want to insert a comma and a space after a series of 
numbers.

To dictate fractions
Click here to display the list of fraction commands you can speak.

See Also
Phrasing Numbers 
Pressing Keys by Voice



    Examples of Inserting Punctuation by Voice    

Example:    Fold the paper lengthwise.
Say fold (pause) the (pause) paper (pause) lengthwise (pause) period.

Example:    Date: May 31, 1996
Say date (pause) colon (pause) May (pause) thirty-one (pause) comma (pause) 
nineteen-ninety-six.

See Also
Pressing Keys by Voice
Punctuating Text 



    Using Kurzweil VoicePad Hands-Free    
Successful hands-free use of Kurzweil VoicePad requires some essential skills. Review 
the following topics to help you get started.

Setting Kurzweil VoicePad Startup Options
Punctuating Text by Voice 
Spelling by Voice
Using the Keyboard Window 
Using Help 
Opening Command Cue Cards 

Working with Documents Hands-Free
Opening a Document 
Saving a File 

For Help on Windows 95 Help
1 Say help to open the Kurzweil VoicePad Help menu.
2 Say how-to-use-help to open Windows Help.



    Setting Kurzweil VoicePad Startup Options
Hands-Free Help
If you are a hands-free user, there are several options you set to make using Kurzweil 
VoicePad hands-free even easier. 
Choose a topic name to display the procedure for setting the option.
Loading a Default Voice Profile at Startup 
Starting Kurzweil VoicePad with the Microphone On
Training Hands-Free Without Confirms 



    Loading a Default Voice Profile at Startup    
Hands-Free Help
You can set Kurzweil VoicePad to automatically load your voice profile when Kurzweil 
VoicePad starts.    You should set this feature only if you are the only person to use 
Kurzweil VoicePad on your PC.
Choose a topic below to see the steps to follow, depending on your PC operating 
system:

Windows 95
Windows 3.1



    Setting Up a Default Profile for Windows 95    
Hands-Free Help
To specify a default profile to load when you start Kurzweil VoicePad, include the profile 
name as a command line property of the Kurzweil VoicePad icon in the Start menu.
To open the Kurzweil VoicePad folder
1 From the Start menu choose Settings -- Taskbar.    The Taskbar Properties dialog appears.
3 Choose the Start Menu Programs tab.
4 Choose Advanced.    The Exploring -- Start Menu dialog appears.
5 Click the Programs folder to open it.
6 Double-click the Kurzweil VoicePad folder to open it.

To specify the profile name as a property of the Kurzweil VoicePad icon
7 Right-click the Kurzweil VoicePad icon.    The pop-up menu appears.
8 Choose Properties.    The Kurzweil VoicePad Properties dialog appears.
9 Choose the Shortcut tab.

10 In the Target text box add a space and the user name at the end of the command line.
Example: C:\KVWIN\KV.EXE -L C:\KVWIN CWS

11 Choose OK.
Each time you start Kurzweil VoicePad, it will automatically load your voice profile.

Note:    If you add other users to Kurzweil VoicePad, you should delete the 
user name from the command line so that each user can select the correct 
voice profile when Kurzweil VoicePad starts.

See Also
Starting Kurzweil VoicePad with the Microphone On 



    Starting Kurzweil VoicePad with the Microphone On    
Hands-Free Help
The Startup with Recognition On option automatically turns on the microphone when 
you start Kurzweil VoicePad. 
To start Kurzweil VoicePad with the microphone on
1 Make the Kurzweil VoicePad main window active.
2 Say menu (pause) options. to display the Options dialog.
3 Say preferences to display the Preferences tab.
4 Say startup-with-recognition-on  to select the option.
5 Say OK to activate the new setting and close the Options dialog.
When you start Kurzweil VoicePad the next time, the microphone will be on when 
Kurzweil VoicePad finishes loading.
To unselect the Startup with Recognition On option
Repeat steps 1 through 5.

See Also
Loading a Default Voice Profile at Startup 
Turning the Microphone On and Off 



 Training Hands-Free Without Confirms    
Hands-Free Help
The Train Without Confirms option lets you dictate speech samples during training 
without pressing the Continue button on the Training dialog. 

Tip:    You must press the Back Up button by mouse or keyboard if you make a
mistake.    If you don't, Kurzweil VoicePad will use the sample recording. 

To select the Train Without Confirms option
1 Make the Kurzweil VoicePad main window active.
2 Say menu (pause) options. to display the Options dialog.
3 Say preferences to display the Preferences tab.
4 Say train-without-confirms to select the option.
5 Say OK to activate the new setting and close the Options dialog.

To unselect the option
Repeat steps 1 through 5.



    Spelling by Voice    
Hands-Free Help
Use the voice alphabet to spell a word by voice.    Say each voice-alphabet word 
followed by a pause.    Say capital- and an alphabet word to capitalize a letter.
EXAMPLE:    Spell McCoy, say capital-mike (pause) charlie (pause) capital-charlie (pause)
october (pause) yankee.
To see the alphabet word list as you work
Say voice-alphabet-cue-card.    
To enter letters into a dialog box
1 If the text box where you want to enter letters does not have focus, say the name of the 

text box, or say tab-key until focus moves to the text box.
2 Say a voice-alphabet word for each letter you want to enter.

To spell a word or press an extended key or key sequence in dictation
You must use the Keyboard window when spelling a word or pressing an extended key or 
key sequence in dictation.
1 Say open-keyboard to open the Keyboard window.
2 Say a voice-alphabet word for each letter you want to insert or each extended key or 

key sequence you want to press.

Tip: To press an extended key sequence, say the key name and voice 
alphabet letter as one phrase.    Example: say control-alpha or alt-alpha.

3 Do one of the following:
Say insert to insert the word or press the indicated keys and leave the Keyboard 
window open.
Say insert-close to insert the word or press the indicated keys and close the Keyboard 
window.

To find a command in the Active Words window
1 Say open-active-words to make the Active Words window active.
2 Begin spelling the command that you are looking for by saying voice-alphabet words.    

As you supply letters, the list changes to include only those commands that match the 
spelling.

Note:    To restore the full list of active commands, say escape-key or clear.

See Also
Examples of Using the Voice Alphabet
Using the Keyboard Window 
Controlling Dialog Boxes



    Using Help Hands-Free 
Hands-Free Help
You can perform the following tasks in Help by voice.
To display Kurzweil VoicePad Help Contents
1 Make the Kurzweil VoicePad main window active.
2 Say help to open the Help menu.
3 Say contents to open Help with the Contents topic displayed.

To display context-sensitive Kurzweil VoicePad Help in dialog boxes
Say help.

When Kurzweil VoicePad Help has focus...

To use menus and dialogs in Help
"Say what you see"; that is, say the name of the menu, menu option, or dialog control as 
you would in Kurzweil VoicePad.    Spell into text boxes using the voice alphabet.    For 
more information on using menus and dialogs, see:
Controlling Menus 
Navigating in and Controlling Dialog Boxes 

To press buttons on the Help button bar by voice
Say the button name. For example, say search.

To choose a topic jump or pop-up
1 Say tab-key until the jump or pop-up you want to choose is highlighted.
2 Say enter-key to open the selected topic or display the pop-up window.
3 If you display a pop-up window, say enter-key again to close it.

Tip:    Rather than say tab-key multiple times, add commands that move the 
insertion point multiple entries. For example, add a command such as tab-2 to
move the cursor two entries, tab-3 to move the cursor three entries, and so 
on. You could also add a back-tab command to move backwards. See Adding a
Command for more information.

To close Help
Say close-application.

See Also
Learning with Kurzweil VoicePad Tutor 



    Opening a Document Hands-Free 
Hands-Free Help

To open a document using Kurzweil VoicePad
1 Open Kurzweil VoicePad.
2 Say file-open. The Open File dialog box appears.

To specify the correct drive and directory, if necessary
3 Say the name of the list box to give it focus.    For example, say directory.    Or say tab-

key until the list box has focus.
4 Say down-arrow and up-arrow as need until the correct selection is highlighted.
5 Say enter-key to choose the selection.
6 Say tab-key to move focus to the File Name box.

To enter the file name in the File Name text box
7 Spell the file name, including the extension, using the voice alphabet.    Say period to 

separate the filename from the extension.
8 Say OK to open the file.



    Saving a File Hands-Free    
To save a file, you need to know how to navigate in a dialog box. 
To save a file using Kurzweil VoicePad
1 Say file-save to display the Save dialog. See Controlling Menus if you need more 

information.
2 Use the tab-key command to move the insertion point to the File Name text box if 

necessary.
3 Clear the File Name text box if it contains unusable text by saying delete-key.
4 Spell the name of the file, including the extension, using the voice alphabet. For 

example, if the file name were ERICA.TXT, you would say: 
echo (pause) romeo (pause) india (pause) charlie (pause) alpha (pause) period 
(pause) tango (pause) x-ray (pause) tango

5 To select a different drive or directory, move the cursor around the dialog box by 
saying the names of the list boxes or by using the tab-key and shift-tab-key 
commands. Move within these lists by say up-arrow or down-arrow as needed using 
the arrow key commands.

6 Say save to save the file and close the dialog box.



    Closing Kurzweil VoicePad Hands-Free
Hands-Free Help

To close Kurzweil VoicePad
1 Make the Kurzweil VoicePad window active.
2 Do one of the following.

Say close-application.
Say file-exit.

3 If prompted, do one of the following.
Say yes to save an open file.
Say no to exit without saving the file.
Say cancel to cancel the close and return to Kurzweil VoicePad.

See Also
Controlling Dialog Boxes 



    How Do I?    
Basics

Learn to use Kurzweil VoicePad through Demo and Practice?
Control the microphone?
Understand how the Kurzweil VoicePad windows work? 
Open and close Kurzweil VoicePad windows?

Dictation
Dictate to Kurzweil VoicePad?
Fix a word that Kurzweil VoicePad misrecognized? 
Delete a word I dictated?
Find what I can say?
Verify what Kurzweil VoicePad heard?
Phrase words and numbers? 
Change capitalization and spacing settings?
Return to dictation if Kurzweil VoicePad recognized a text word as a command?

Navigation and Control
Control the menus?
Know what commands I can say? 
Control the Kurzweil VoicePad Window?
Navigate in a document?
Keep my place within a document?

Advanced
Speak ahead and make edits later? 
Add a Command? 
Add a Free Text Word? 

For Help on Help, press F1.



    Verifying What Kurzweil VoicePad Heard 
To verify what Kurzweil VoicePad last heard, look in the Last Word Heard panel in the 
Kurzweil VoicePad main window.If Kurzweil VoicePad does not recognize what you said, 
it displays the message 'Word not recognized' in the panel or the status message 
blinks.
To correct a misrecognition
Use the take- and correct-that commands to correct a misrecognition and help Kurzweil 
VoicePad adapt to your speaking style.

Note:    If the Take window remains blank, Kurzweil VoicePad has lost your 
place, and you cannot use these voice commands. Click in your document and
resume dictation.

If Kurzweil VoicePad misrecognized what you said and executed an application
command, you need to take corrective action within the application rather 
than use correct-that.

If you experience persistent recognition problems with a specific word or phrase, choose 
the Recognition Wizard option from the Kurzweil VoicePad menu, and select the problem 
from the list that best describes the problem you are having.

See Also
Correcting:    Fixing Kurzweil VoicePad Misrecognitions 
Using the Take Window 



    Finding What You Can Say    
Kurzweil VoicePad provides active commands based on your location.    All currently 
active commands are listed in the Active Words window.
To find a command in the Active Words window
1 Say open-active-words or click on the Active Words window to make it active.
2 Begin typing or using the voice alphabet to spell the command you want to find.    As 

you supply letters, the display changes to show only commands that match your 
entry.    The commands are grouped by command list.

3 If the word:
Appears in the list, you can say it or select it.
Appears marked by a red diamond (), then you need to train the word.
Does not appear in the list, it may be active in another location.    For example, if 
you are currently dictating to a word processor, voice alphabet commands are not 
active.
Does not appear in the list, but you want to add it, see Adding a Command or 
Adding a Free Text Word.

Note:    You can also say page-up  and page-down  or use the scroll bar to 
move through the list either before or after you begin spelling.

To restore the full list of active commands
Do one of the following:

Press or say escape-key.
Say clear.
Choose Clear from the Edit menu.

See Also
Understanding Command Lists 



    Returning to Dictation When Kurzweil VoicePad Misrecognizes
a Word for a Command

If Kurzweil VoicePad misrecognizes a word for an application command and performs 
the command action, follow these instructions to correct this problem.
To correct this type of misrecognition
1 Look in the Last Word Heard panel to determine what Kurzweil VoicePad heard you say.
2 Do one of the following:

If a dialog box appears as a result of the misrecognition, choose the Cancel button.
If a formatting command altered the contents of the document, use the Undo 
command.
If an application setting or preference was changed, access the setting from the 
menu and return it to its previous setting.

3 If necessary, move the insertion point to its correct place in the document.

To prevent the misrecognition in the future
1 Choose Recognition Wizard from the Kurzweil VoicePad menu.
2 Select Confuses a pair of words from the problem list. 
3 Follow the prompts to train the word that you said and the word that Kurzweil 

VoicePad heard (in the Last Word Heard panel).



    Keeping Your Place Within a Document
When you switch between Kurzweil VoicePad and another application, return to Kurzweil
VoicePad by clicking on the Kurzweil VoicePad title bar.    Doing so keeps the insertion 
point in the same place in your document and preserves the alternatives    in the Take 
window. 

Note: If the Take window remains blank, Kurzweil VoicePad has lost context. 
Click in your document and resume dictation.



    Speaking Ahead with Kurzweil VoicePad    
You can speak ahead of Kurzweil VoicePad and use the back-up- commands to make 
your corrections. 
Use the Take window as a reference when backing up through your document to correct
misrecognitions.    As you move backwards in your document within the back-up range, 
the Take window shows the current word based on your current position in the 
document.
Backing up to make corrections
You can back up as many as 20 words in your document by voice using the back-up-1 
through back-up-4 commands. Within this 20-word range, you can still use the correct-that,
take-, or delete-that commands and then use forward- or move-on to move ahead again. If 
you move the insertion point beyond the back up range of 20 words, the Take window 
clears and you cannot use these commands.    Use your mouse and keyboard to make edits 
outside the back-up range.



    Controlling the Kurzweil VoicePad Window    
Kurzweil VoicePad lets you control the window size by voice comands.
To minimize the Kurzweil VoicePad window
Say minimize-application.

To maximize the Kurzweil VoicePad window
Say maximize-application.

To exit Kurzweil VoicePad
Say close-application.



    Keyboard Commands
((This is purely a place holder.    There are no jumps to it, and it is no longer accessed by Search 
Keyword.    The duplicate topic is in basics.doc.    All jumps to the command topics in this file originate 
in KYBRD.SHG, which is the duplicate topic in basiscs.doc.))



Backspace
Say backspace-key.



Page Up
Say page-up.



Page Down
Say page-down.



Enter
Say enter-key or return-key.



Spacebar
Say spacebar.



Up Arrow
Say up-arrow.



Down Arrow
Say down-arrow.



Left Arrow
Say left-arrow.



Right Arrow
Say right-arrow.



Tab
Say tab-key.



Home
Say home-key.



Delete
Say delete-key.



Insert
Say insert-key.



End
Say end-key.



Escape
Say escape-key.



F1
Say F-one. 



F2
Say F-two. 



F3
Say F-three. 



F4
Say F-four. 



F5
Say F-five. 



F6
Say F-six. 



F7
Say F-seven. 



F8
Say F-eight. 



F9
Say F-nine.



F10
Say F-ten. 



F11
Say F-eleven.



F12 
Say F-twelve.



Alt 
To press this key alone, say alt-key.
To press it in combination with another key, say alt and the second key as one phrase. 
For example, say alt-SIERRA to press ALT + S simultaneously by voice, or say alt-end-
key to press that key combination by voice.



Ctrl 
This key works in combination with another key. 
Say control and the second key as one phrase. For example, say control-SIERRA to 
press CTRL + S simultaneously by voice, or say control-end-key to press that key 
combination by voice.



Shift 
This key works in combination with another key.
To press it in combination with another key, say shift and the second key as one phrase.
For example, say shift-F-eleven to press SHIFT + F11 simultaneously by voice.
To capitalize a letter when spelling by voice, use the capital- command with the voice 
alphabet. For example, say capital-SIERRA to capitalize the letter S.



~ Say tilde.
` Say backquote.



! Say exclamation-point.
1 Say one.



@ Say at-sign.
2 Say two.



# Say number-sign.
3 Say three.



$ Say dollar-sign.
4 Say four.



% Say percent.
5 Say five.



^ Say caret.
6 Say six.



& Say ampersand.
7 Say seven.



* Say asterisk.
8 Say eight.



( Say open-paren.
9 Say nine.



) Say close-paren.
0 Say zero.



_ Say underbar.
- Say hyphen.



+ Say plus-sign.
= Say equal-sign.



| Say vertical-bar.
\ Say backslash.



{ Say open-curley.
[ Say open-bracket.



} Say close-curley.
] Say close-bracket.



:    Say colon.
;    Say semi-colon.



" Say open-quote or close-quote.
Use the appropriate command to insert the correct spacing in your document.
Command Spacing
open-quote Does not insert a space after the quote. 
close-quote Inserts a space after the quote. 

'  Say apostrophe, single-quote, open-single-quote, close-single-quote
Use the appropriate command to insert the correct spacing in your document.
Command Spacing
apostrophe Does not insert a space before or after the apostrophe.
single-quote Inserts a space before and after quote.
open-single-quote Inserts a space before but not after the quote.
close-single-quote Does not insert a space before but inserts a space after the quote.



< Say open-angle.
,    Say comma when dictating words. In this instance, Kurzweil VoicePad inserts a 

space after the comma.
Say numeric-comma when inserting a comma in a series of numbers. In this 
instance, Kurzweil VoicePad does not insert a space after the comma.



 > Say close-angle.
.  Say period to end a sentence. This inserts the correct spacing between sentences.

Say decimal-point when you want to insert decimal point in a series of numbers. 
This command does not insert spaces between the numbers.



? Say question-mark.
/ Say slash.



a Say ALPHA.
A Say capital-ALPHA.



b Say BRAVO.
B Say capital-BRAVO.



c Say CHARLIE. 
C Say capital-CHARLIE.



d Say DELTA 
D Say capital-DELTA.



e Say ECHO.
E Say capital-ECHO.



f Say FOXTROT. 
F Say capital-FOXTROT.



g Say GOLF. 
G Say capital-GOLF.



h Say HOTEL. 
H Say capital-HOTEL.



i Say INDIA. 
I Say capital-INDIA.



j Say JULIET.
J Say capital-JULIET.



k Say KILO.
K Say capital-KILO.



l Say LIMA. 
L Say capital-LIMA.



m Say MIKE. 
M Say capital-MIKE.



n Say NOVEMBER.
N Say capital-NOVEMBER.



o Say OSCAR. 
O Say capital-OSCAR.



p Say PAPA. 
P Say capital-PAPA.



q Say QUEBEC. 
Q Say capital-QUEBEC. 



r Say ROMEO. 
R Say capital-ROMEO. 



s Say SIERRA.
S Say capital-SIERRA. 



t Say TANGO.
T Say capital-TANGO. 



u Say UNIFORM. 
U Say capital-UNIFORM.



v Say VICTOR. 
V Say capital-VICTOR.



w Say WHISKEY. 
W Say capital-WHISKEY.



x Say X-RAY. 
X Say capital X-RAY.



y Say YANKEE. 
Y Say capital-YANKEE.



z Say ZULU. 
Z Say capital-ZULU.



Pause/Break
Say break-key.



7 Say seven.
Home Say home-key.



8 Say eight.
Up Arrow Say up-arrow.



9 Say nine.
PgUp Say page-up.



4 Say four.
Left Arrow Say left-arrow.



5 Say five.



6 Say six.
Right Arrow Say right-arrow.



1 Say one.
End Say end-key.



2 Say two.
Down Arrow Say down-arrow.



3 Say three.
PgDn Say page-down.



0 Say zero or oh.
InsertSay insert-key.



. Say period to end a sentence. This inserts the correct spacing between sentences.
Say decimal-point when you want to insert decimal point in a series of numbers. 
This command does not insert spaces between the numbers.

Del Say delete-key.



Enter Say enter-key.



+ Say plus-sign.



- Say minus-sign.



* Say asterisk.



/ Say slash.



Scroll Lock
Say scroll-lock.



Num Lock
Say num-lock.



Caps Lock
Say caps-lock.



Print Screen
Say print-screen.



    First-Time Users    
Using Kurzweil VoicePad successfully requires some essential skills. To acquire these 
skills, run the Kurzweil VoicePad Demo and do the Kurzweil VoicePad Practice.
To run Kurzweil VoicePad Demo or Practice
Do one of the following:

Click the Demo or Practice button on the opening Overview screen.
Open the VoicePad menu and choose Demo or Practice. 

Click on a topic below to find out more about Kurzweil VoicePad
How Do I Start?
What Is Voice Focus?
What Can I Say? 
How Do I Say It?
How Do I Correct Kurzweil VoicePad Misrecognitions?
How Do I Rewrite Text When I Change My Mind? 
Is Kurzweil VoicePad Listening?



    How Do I Start?
To begin using Kurzweil VoicePad
1 If Kurzweil VoicePad is not running, open it from the Kurzweil VoicePad icon.
2 Put on the microphone and position it correctly.
3 Choose your name from the Start User dialog box or create a new user.
4 If you are prompted to complete a sound levels check, follow the prompts when the 

Sound Levels dialog appears.
5 Press CTRL+ALT to turn the microphone on.
6 Begin dictating.
Use the Active Words window to find what you can say.



    What Is Voice Focus?
Voice focus refers to the window that you can currently speak to with Kurzweil VoicePad.
The window may display a Kurzweil VoicePad document, or it may be one of the 
Kurzweil VoicePad windows or dialogs.    A highlighted title bar means the window is 
active and has voice focus; a dimmer (often gray) title bar indicates that the window is 
not active and does not have voice focus.
If a window or dialog box doesn't have voice focus, you can't talk to it.    To make it 
active, click on the title bar of the window, or say open- and the name of the window as 
one phrase.



    What Can I Say?    
When you speak to Kurzweil VoicePad, you are either dictating free text words or 
numbers or speaking commands.
Dictating Free Text Words and Numbers
You can say any word you want when you are dictating.    If Kurzweil VoicePad neither 
correctly recognizes the word nor displays the word in the Take window, you can correct
or add the word using the correct-that command.    For guidelines on dictating numbers,
see Phrasing Numbers.
Speaking Commands
Menu and Dialog Commands --Say What You See
When speaking commands for menus and dialog box labels, say what you see.    To 
display the edit menu, say edit-menu. Then "say what you see" to select an option from
that menu. For example, say cut.
Shortcut Commands
Kurzweil VoicePad also provides shortcut commands that you can use without 
displaying a menu. These commands correspond to the options that have shortcut keys 
on a menu. Shortcut commands combine the menu and option as one phrase.    For 
example, you can say edit-cut instead of edit-menu (pause) cut.
You can add your own shortcut commands.
Kurzweil VoicePad and Navigation Commands
The Active Words window shows all the commands you can say in your current location. 
The commands listed include Kurzweil VoicePad commands and Windows navigation 
commands.    You can speak pretrained commands immediately.
Using Command Cue Cards
To see a quick reminder of commands you can speak, open a cue card.



    How Do I Say It?
Tips for speaking to Kurzweil VoicePad 
Kurzweil VoicePad can understand you best when you follow the guidelines listed below.
Speaking Style Guidelines
Volume Speak as you would normally speak to someone sitting 

across the desk from you. Do not speak too loudly.
Speaking Rate Pause briefly, less than a 1/6 of a second, between 

words and word phrases but do not draw them out 
unnaturally. Kurzweil VoicePad defines words by 
hearing these pauses. If you speak too quickly or too 
slowly, Kurzweil VoicePad will misrecognize you. To 
adjust the length of the pause, see Setting Recognition 
Options.
Examples: 

Say to (pause) whom (pause) it (pause) may (pause)
concern (pause) colon 
Say file-menu (pause) open.

See Phrasing Numbers to learn the guidelines for 
dictating numbers.

Pronunciation Pronounce words as you normally do.    Do not over 
enunciate.

Noises Be aware of any extra sounds you might make, such as
tongue clicks, clearing your throat, inserting "uhs" or 
"ahs" between words, or "thinking aloud." Also be 
aware of any background sounds, such as colleagues 
conversing or a radio playing. Loud extraneous noises 
or soft unintentional noises can cause misrecognitions.

Tip:    Speak all hyphenated command phrases as one word.

Use the correct-that and take- commands to correct Kurzweil VoicePad misrecognitions. 
Remember that Kurzweil VoicePad learns your voice and adjusts your profile so that it 
recognizes you better. Kurzweil VoicePad also adjusts to changing noise conditions.
See Also
Helping Kurzweil VoicePad Adapt to Your Speaking Style 
Identifying Recognition Problems 



    How Do I Correct Kurzweil VoicePad Misrecognitions?
Sometimes Kurzweil VoicePad misrecognizes you and hears something different from 
what you said. When this happens, say:

take- and the number of the alternative if the correct word appears in the Take 
window. For example, say take-2 to take the second alternative. Kurzweil VoicePad
swaps the word you choose for the word it heard.
correct-that if the correct alternative does not appear in the Take window.

Do not use the delete-that command to correct a misrecognition because that command 
does not help Kurzweil VoicePad adapt to your speaking style.

Note: If the Take window remains blank, you cannot use these commands 
because Kurzweil VoicePad has lost context.    Click in your document to use 
standard editing features to make corrections.

Click a topic below for more information.
Using these correction commands
See Correcting:    Fixing Kurzweil VoicePad Misrecognitions
Correcting persistent misrecognitions
See Using the Recognition Wizard.
Editing your dictation
See How Do I Rewrite Text When I Change My Mind?
See Also
Overview of Correcting and Editing



    How Do I Rewrite Text When I Change My Mind?
If you change your mind about a word that Kurzweil VoicePad recognized correctly, 
use the delete-that command.

Important: Don't use the take- or correct-that commands to rewrite text that
Kurzweil VoicePad recognized correctly.    Because these commands help 
Kurzweil VoicePad adapt    to your speaking style, use them only for 
misrecognitions.

To rewrite your text

To delete Use
The current word The delete-that command.
One of the last 20 
words dictated

The back-up-1 through back-up-4 commands 
one or more times to move within the back-up 
range. Then use the delete-that command and 
dictate a change.    To resume dictation after you
edit, say move-on to move the insertion point to
its location before you backed up.

Any other words Your mouse or keyboard. Outside of the back-up
range, Kurzweil VoicePad loses context and the 
Take window clears.    To resume dictation after 
you edit, click in your document and begin 
speaking again.

Example
Click here to display an example of rewriting your text.
See Also
Overview of Correcting and Editing
Correcting:    Fixing Kurzweil VoicePad Misrecognitions



    Is Kurzweil VoicePad Listening? 
As you speak, is Kurzweil VoicePad responding?    If not, click on the highlighted text 
below to display troubleshooting information.

Is the microphone plugged in correctly?    Check your manutacturer's instructions.

Do you have the microphone positioned properly?

Is the microphone indicator green?

Is the title bar highlighted for the document you want to dictate to? 

Does the Take window display the word Kurzweil VoicePad heard, plus as many as 
four alternatives?

Is the word or command you want to say trained and active for your location?

See Also
Verifying What Kurzweil VoicePad Heard
Identifying Recognition Problems 



Is the microphone indicator green? 
Kurzweil VoicePad hears you only when the microphone indicator is green.
If it is gray and the status line in the Kurzweil VoicePad Center says:

'Ctrl + Alt turns on the microphone,' press CTRL + ALT or use your mouse to click 
on the microphone indicator.
'Say Listen-to-me,' say listen-to-me.



Is the title bar highlighted for the document you want to dictate to? 
If the title bar is dimmed, the window is not active (does not have voice focus) and you 
cannot speak to it.    Also, if you wish to voice-enable applications other than VoicePad, 
you will have to upgrade to a full version of Kurzweil VOICE.    Please call 1-800-380-
1234 to contact Kurzweil Applied Intelligence about upgrading.



Does the Take window display the word Kurzweil VoicePad heard, plus as many 
as four alternatives?
If you have been dictating but the Take window remains blank, Kurzweil VoicePad has 
lost context and no longer knows the current word.    This occurs when you move the 
insertion point by mouse or keyboard. To resume, click in your document and begin 
dictating again.



Do you have the microphone positioned properly?
Follow these guidelines.

Secure the microphone on your head.
Place the microphone mount on the left or right side of your mouth.
Turn the flat surface of the microphone toward the left or right corner of your 
mouth, as close as you can without touching. If what you say is often 
misrecognized, check the microphone position. 



Is the word or command you want to say trained and active for your location?
Kurzweil VoicePad can recognize a command only if it is trained.    Furthermore, what 
you can say depends on your location in a window, menu, or dialog box.    You may be 
trying to say a command that isn't active for your current location.    For example, if the 
Kurzweil VoicePad Center window is active, you can't say file-open.
To find out if a word or command is active
Say open-active-words or click on the Active Words window to make it active.    Then use 
one of these methods to find a command on the Active Words window:

Type the command name.
Spell the command name by voice alphabet.

All the commands that match the letters or words you supply appear grouped by 
command list in the Active Words window.

Note: To restore the full list of available commands, press or say escape-key 
or choose Clear from the Edit menu by either:
-- Saying clear
-- Using your mouse or keyboard

To use a command after you find it
Use either of these methods:

Choose Say from the Edit menu or the pop-up menu on the Active Words window.
Make the Kurzweil VoicePad dictation window active and say the command 
phrase.

If the command you need does not appear in the Active Words list
You can add the command. See Adding a Command.



    Tuning and Troubleshooting
Choose a topic to display the topic contents.
Boosting Recognition Accuracy 

Overview:    Helping Kurzweil VoicePad Adapt
Training Commands and Words to Improve Recognition 
Using Take- and Correct-That to Improve Recognition

Boosting Dictation Throughput
Adjusting the Speed:Accuracy Ratio
Adjusting Word Gap

Troubleshooting Recognition Problems
Identifying Recognition Problems 
Using the Recognition Wizard
Checking Sound Levels 
Adjusting Microphone Gain
Setting Recognition Options 

Maintaining Voice Profiles
Creating a Voice Profile 
Selecting a Voice Profile 
Saving Your Voice Profile
Saving Your Voice Profile with a Confirm 
Deleting a Voice Profile 
Loading a Default Voice Profile at Start Up 

For Help on Help, press F1.



    Overview:    Helping Kurzweil VoicePad Adapt 
There are several ways to help Kurzweil VoicePad adapt to your speaking style.    Click 
on green headings below for more information about a topic:
Correct Kurzweil VoicePad Misrecognitions 
You can help Kurzweil VoicePad adapt to the way you speak by correcting words or 
commands that it misrecognizes.

Use the take- command when Kurzweil VoicePad misrecognizes a word and the 
correct word appears in the Take window. 
Use the correct-that command when Kurzweil VoicePad misrecognizes a word and 
the correct word does not appear in the Take window.
Use the delete-that command only when you change your mind and want to 
delete a word that Kurzweil VoicePad recognized correctly.

Use the Recognition Wizard
The Recognition Wizard helps you solve persistent recognition problems by guiding you 
through corrective actions. Use the Recognition Wizard if:

Kurzweil VoicePad consistently misrecognizes a word.
Kurzweil VoicePad consistently mistakes one word for another word.
Kurzweil VoicePad does not hear you when you speak.
Kurzweil VoicePad consistently hears one word no matter what you say.
You experience poor recognition.

Check Sound Levels
Kurzweil VoicePad maintains a representation of the difference between your voice and 
the background noise in your environment. You need to perform a sound levels check if:

Kurzweil VoicePad prompts you. 
You experience a significant change in the level or type of background noise in 
your working environment that decreases your recognition accuracy. 
You experience a decrease in your recognition accuracy.
The recognition wizard prompts you after selecting from the problems list.
You switch to using a different sound board and/or microphone.

See Also
Tuning and Troubleshooting



    Training Commands and Words to Improve Recognition
When you train a command or word, Kurzweil VoicePad records a sample of how you 
say it. This helps Kurzweil VoicePad adapt to your voice. You need to train a command 
or word if: 

Kurzweil VoicePad consistently misrecognizes it.
Kurzweil VoicePad confuses two words.
The command is untrained.

Train from the Recognition Wizard or Active Words window window. If you have added a 
number of new commands, you can train all untrained words.

Note: The information that Kurzweil VoicePad collects when you train 
commands and words is stored in your voice profile, which you or your system
administrator should back up regularly.

See Also
Training a Selected Command or Word 
Training All the Commands in One Command List
Training Menu Commands
Training Commands for Kurzweil VoicePad Windows
Training Untrained Commands 
Using the Active Words Window 
Using the Recognition Wizard



    Training a Selected Command or Word    
When you train a command or word, Kurzweil VoicePad records a sample of how you 
say it to help adapt to your speaking style. 
Until you become familiar with Kurzweil VoicePad, use the Recognition Wizard to train a 
word that is consistently misrecognized. Once you become more familiar with Kurzweil 
VoicePad, you can use the Active Words  window to complete this procedure.

Note: If the command or word does not appear in the Active Words list, it is 
not an active word in the system. To correct this problem, exit from this 
procedure and add the command or add the word.

To train a selected command or word using the Recognition Wizard
1 Say recognition-wizard or choose Recognition Wizard from the Kurzweil VoicePad menu.
2 Select the first problem from the list: Doesn't recognize your word. 
3 Choose Solve. 
4 Enter or select a command or word.
5 Choose Solve.
4 Follow the prompts to record speech samples.

To train a selected command or word using the Active Words window
1 If the command you want to train is for a dialog box label, open the dialog box and 

make it active.
2 Say open-active-words or click on the Active Words window.
3 Find and highlight the command or word you want to train.    If the command is in the 

Kurzweil VoicePad Menu Commands list, see Training Menu Commands for a different 
procedure.    If the command is for a Kurzweil VoicePad window or dialog box, see Training
Kurzweil VoicePad Window and Dialog Box Commands.

4 Choose Selected from the Train menu or choose Train from the pop-up menu.    The Train 
Word dialog box appears.

5 Follow the prompts to record speech models.

Note: The information that Kurzweil VoicePad collects when you train 
commands and words is stored in your voice profile, which you or your system
administrator should back up regularly.

See Also
Training All the Commands in One Command List
Training Menu Commands
Training Commands for Kurzweil VoicePad Windows
Training Untrained Commands 
Using the Active Words Window 
Using the Recognition Wizard



    Training Untrained Commands    
Use the Active Words window to train any the untrained commands.    For commands in 
the Kurzweil VoicePad Menu Commands list, see Training Menu Commands for a 
different procedure.
To train untrained commands
1 Say open-active-words or click in the Active Words window to make it active.
2 Select Untrained from Train menu.
3 Follow the prompts to provide speech samples.    You will be prompted to train every 

untrained command.

Note: The information that Kurzweil VoicePad collects when you train 
commands is stored in your voice profile, which you or your system 
administrator should back up regularly.    

See Also
Training a Selected Command or Word 
Training All the Commands in One Command List
Using the Active Words Window 



    Training All the Commands in One Command List
When you train a command, Kurzweil VoicePad records a sample of how you say it to 
help adapt to your speaking style. 
To train all the words in a selected command list
1 If the command list you want to train is for a dialog box label in a dialog box, open 

the dialog box and make it active.
2 Say open-active-words or click on the Active Words window.
2 Highlight the name of the command list you want to train.
3 Choose Selected from the Train menu or choose Train from the pop-up menu.    The Train 

Word dialog box appears.
5 Follow the prompts to record speech samples.

Note: The information that Kurzweil VoicePad collects when you train 
commands and words is stored in your voice profile, which you or your system
administrator should back up regularly.

See Also
Training a Selected Command or Word 
Training Menu Commands
Training Commands for Kurzweil VoicePad Windows
Training Untrained Commands 
Using the Active Words Window 



    Training Menu Commands    
If you experience a recognition problem with a command on a menu, you can usually 
solve the problem by training the command from the Menu Command Training dialog.    
When you train a command, Kurzweil VoicePad records a sample of how you say it to 
help adapt to your speaking style.
To display the Menu Command Training dialog
1 Say open-active-words or click on the Active Words window.
2 Choose Menu Commands from the Train menu.    The Menu Command Training dialog 

appears.

To train a selected menu command
1 Display the Menu Command Training dialog as described above.
2 Find the command you want to train and highlight it.
3 Choose Selected.    The Training dialog appears.
4 Follow the prompts to record speech samples.

To train all menu commands
1 Display the Menu Command Training dialog as described above.
2 Choose All Words.    The Training dialog appears.
3 Follow the prompts to record speech samples.

To train only untrained menu commands
1 Display the Menu Command Training dialog as described above.
2 Choose Untrained.    The Training dialog appears.
3 Follow the prompts to record speech samples.

See Also
Training Commands for Kurzweil VoicePad Windows
Using the Active Words Window 



    Training Commands for Kurzweil VoicePad Windows
If you experience a recognition problem with a command to use a Kurzweil VoicePad 
window or dialog, you can usually solve the problem by training the command from the 
VOICE Command Training dialog.    When you train a command, Kurzweil VoicePad 
records a sample of how you say it to help adapt to your speaking style.
To display the VOICE Command Training dialog
1 Say open-active-words or click on the Active Words window to make it active.
2 Choose VOICE Commands from the Train menu.    The VOICE Command Training dialog 

appears.

To train a selected Kurzweil VoicePad command
1 Display the VOICE Command Training dialog as described above.
2 Find the command you want to train and highlight it.
3 Choose Selected.    The Training dialog appears.
4 Follow the prompts to record speech samples.

To train all Kurzweil VoicePad commands
1 Display the VOICE Command Training dialog as described above.
2 Choose All Words.    The Training dialog appears.
3 Follow the prompts to record speech samples.

See Also
Using the Active Words Window 



    Using Take- and Correct-That to Improve Recognition    
Use the take- and correct-that commands to correct a misrecognition or to add a free 
text word. Kurzweil VoicePad continually    to your voice, and these commands are an 
efficient way of training it to recognize how you say a specific word or phrase.    
You should avoid using the delete-that command to correct a misrecognition because 
you lose the opportunity to improve Kurzweil VoicePad's recognition.

Note: The information that Kurzweil VoicePad collects when you use correct-
that and take- is stored in your voice profile, which you or your system 
administrator should back up regularly.

See Also
Correcting:    Fixing Kurzweil VoicePad Misrecognitions 
Using the Take Window 
Using the Correct-That Window 



    Identifying Recognition Problems
Some recognition problems can be easily remedied by following the guidelines listed 
below. If you are following these guidelines and your recognition problem continues, use
the Recognition Wizard to solve your problem.
If Kurzweil VoicePad does not hear anything you say

Make sure the microphone indicator is green. 
If Kurzweil VoicePad hears you but does not respond

Check the Take window.    If it remains blank, Kurzweil VoicePad has lost context. 
Click in your document and resume your dictation.
Check the window you are working in to make sure it is active.    If the title bar is 
not highlighted, click on it to switch focus and make the window active.
Check the Active Words window to be sure the command you are saying is active 
and is trained.

Speaking
Pause between words or phrases. Say To (pause) whom (pause) it (pause) may 
(pause) concern.    If Kurzweil VoicePad recognizes a single word or phrase as 
separate words, raise your Word Gap setting.    For example, if blackboard is 
recognized as "black board" or if take-2 is recognized as "take two," then raise your 
word gap setting.    See Setting Recognition Options.
Do not pause in the middle of a phrase. Say file-menu not file (pause) menu. Or say 
three-dash-four-dash-nine-four not three (pause) dash (pause) four (pause) dash 
(pause) nine (pause) four.
Do not over-enunciate or speak too loudly.

Kurzweil VoicePad eavesdrops
Turn off the microphone when you are not speaking. 
Do not talk to yourself.
Avoid saying "ums," "ers," and mouth clicks.

See Also
Speaking So Kurzweil VoicePad Can Understand You 
Controlling the Microphone 



    Checking Sound Levels    
Kurzweil VoicePad maintains a representation of the difference between your voice and 
the background noise in your environment.    Choose a topic to read about:

When to check sound levels
Guidelines for checking sound levels

Successful Sound Levels Check
A successful sound levels check captures your voice and the typical level of background
noise in your working environment. The sound levels meter results vary depending on 
your environment. However, the meter reading for the words you speak should register 
more than 2 ticks higher than the meter reading for background noise, as illustrated in 
this picture:

Note:    If you do not observe this contrast, complete the sound levels check 
and try dictating.    If your recognition is poor, do one or more of the following:

Perform another sound levels check
Choose the Mike Gain button on the Sound Levels dialog to raise the 

microphone gain
Use the Recognition Wizard
Check the fidelity of your sound board
Adjust microphone gain outside Kurzweil VoicePad

To record sound levels 
1 Say sound-levels or choose Sound Levels from the Kurzweil VoicePad menu.
2 When you are ready to record, choose the Continue button. Remain silent but breathe 

normally while Kurzweil VoicePad records the background noise.
3 Do one of the following:

If Kurzweil VoicePad recorded an accurate sample of your background noise, choose
Continue.
If an extraneous noise occurred, choose Backup and record the sample again. 

4 Follow the prompts to record the test words. The sound levels meter reading should 
register more than 2 ticks above the background levels reading for each sample.

If Kurzweil VoicePad recorded an accurate sample, choose Continue.
If an extraneous noise occurred or you do not think the sample reflected the way 
you normally speak, choose Backup and record the sample. 

5 Choose OK to close the dialog box when you finish.



    When to Check Sound Levels
You need to perform a sound levels check if:

Kurzweil VoicePad prompts you to do so. 
You experience a significant change in the level or type of background noise in 
your working environment that decreases recognition accuracy.
You experience a decrease in recognition accuracy for other reasons.
You suspect a problem with your microphone.
You switch to a different sound board and/or microphone.

See Also
Guidelines for Checking Sound Levels 
Successful Sound Levels Check 



    Guidelines for Checking Sound Levels
Follow these guidelines when you perform a sound levels check:

When recording both background noise and spoken words, position the 
microphone the way you would if you were dictating.
Breathe normally, but do not speak or cover the microphone while Kurzweil 
VoicePad is recording a sample of the background noise.
Rerecord a sample if an extraneous noise occurs while Kurzweil VoicePad is 
recording either the background noise or your voice. Extraneous noise includes 
coughing, a telephone ring, or someone speaking to you.

See Also
When to Check Sound Levels 
Successful Sound Levels Check 



    Checking Sound Board Fidelity
You should check the quality of the signal from your microphone and sound board after 
installation or anytime you suspect you might have a problem with them.    Make sure 
your microphone is properly connected according to the manufacturer's instructions.
To record and test
1 Open Windows Sound Recorder or the recorder that comes with your sound board.    The 

name of the recorder varies with different sound boards.
2 Set recording and playback levels to approximately half scale.
3 Set sound format to 22Khz or higher, 16 bit.
4 Speak into the microphone for a few seconds to record your voice.
5 Play back what you recorded.

What to listen for
Your voice recording should be audible with no loud buzzing or crackling in the background. 
If the volume is too low, or if there is no sound at all in the recording, see Adjusting 
Microphone Gain Outside Kurzweil VoicePad for instructions for verifying that your 
microphone gain settings are adjusted correctly.
If you can't hear your recording clearly, check that the microphone connectors are 
firmly seated in the correct jacks, and that your sound board software is properly 
installed.    Refer to your sound board documentation for further help.



    Sound Board Compatibility
Extensive steps have been taken to ensure that Kurzweil VoicePad is compatible with 
Sound Blaster 16-compatible and 16-bit Windows-compatible sound boards.    At the 
time of this release, Kurzweil Applied Intelligence is not aware of any sound boards that
Kurzweil VoicePad does not support.    If you nevertheless experience recognition 
difficulty or find that the microphone doesn't hear anything you say, choose a topic 
below for more information.
Incorrect microphone gain
Because of variations in gain among sound boards, Kurzweil VoicePad's default microphone
gain setting may be incorrect for your sound board.    If recognition appears to be poor or 
erratic during your initial stages of using Kurzweil VoicePad, see Adjusting Microphone Gain 
Inside Kurzweil VoicePad for information on correcting the problem.
Nonconforming sound board
Usually you can use Kurzweil VoicePad to control your microphone gain, but if your 
computer's sound board does not conform to accepted Windows conventions, you may 
need to see Adjusting Microphone Gain Outside Kurzweil VoicePad for information on 
correcting the problem.



    Creating a Voice Profile
If you are a new Kurzweil VoicePad user, you need to create a voice profile. Your profile 
helps Kurzweil VoicePad recognize you when you speak.
To create a voice profile
1 Open Kurzweil VoicePad.    The Start User dialog appears.
2 Choose New.    The New User dialog appears.
3 In the New User Name text box, type your user name.
4 Do one of the following.

Select your gender. 
Select Child for a young user. Generally, this setting is appropriate for an 
adolescent whose voice has not reached full maturity.

Note:    If you do not select Child, it is important to select the correct gender. 
Selecting the wrong gender will result in poor recognition.

5 Choose OK. Kurzweil VoicePad creates a new voice profile and displays the new user 
name highlighted in the Start User dialog.

6 Choose OK to open Kurzweil VoicePad using the new voice profile.

See Also
Selecting a Voice Profile 
Deleting a Voice Profile 
Saving Your Voice Profile 
Loading a Default Voice Profile at Start Up 



    Selecting a Voice Profile    
Before you begin using Kurzweil VoicePad, you must select your voice profile. Selecting 
the correct profile is important because it helps Kurzweil VoicePad recognize you when 
you speak.    In addition, Kurzweil VoicePad adapts to your speaking style as you work, 
so you should never use someone else's profile and risk corrupting that person's voice 
profile data with your own speech.
To select your voice profile 
1 Open Kurzweil VoicePad.    The Start User dialog appears.
2 Select your name from the list.
3 Choose OK. Kurzweil VoicePad loads your voice profile into the computer.

Tip: You cannot select or add a voice profile once you have started Kurzweil 
VoicePad.    If another user wants to use Kurzweil VoicePad, you must exit from
the current session and restart Kurzweil VoicePad to select or create that 
user's profile.

See Also
Creating a Voice Profile 
Deleting a Voice Profile 
Saving Your Voice Profile 
Loading a Default Voice Profile at Start Up 



    Saving Your Voice Profile    
Kurzweil VoicePad adapts to your speaking style by saving information from every 
session to your voice profile that helps it recognize you. Just like any document, you 
should periodically save your voice profile as you work to ensure that data is not lost. 
You can do this by using the save-profile command or by exiting from Kurzweil 
VoicePad.

Tip:    If you have trained a large number of words, you should save your voice
profile.    In addition, you or your system administrator should back up your 
voice profile regularly.

To save your voice profile
Say save-profile. Kurzweil VoicePad prompts you to confirm.
or
Exit from Kurzweil VoicePad by saying close-application when the Kurzweil VoicePad 
Center is active or choosing Exit from the Kurzweil VoicePad menu.

Note: If you do not want to save profile information when you exit from this 
session, see Saving Your Voice Profile with a Confirm.

See Also
Creating a Voice Profile 
Deleting a Voice Profile 
Selecting a Voice Profile 



    Saving Your Voice Profile with a Confirm
Kurzweil VoicePad adapts to your speaking style each time you use it by saving 
information in your voice profile when you exit. However, there may be times when you 
don't want to save your profile; for example, a cold has changed the quality of your 
voice or you mistakenly used the wrong profile when dictating.    Click here for more 
information 
You can add a prompt that will ask you whether or not you want to save your current 
session's information to your voice profile.
To add a confirm prompt
1 Make the Kurzweil VoicePad Center window active.
2 Say menu (pause) options or choose Options from the menu.    The Options dialog 

appears.
3 Say preferences or choose the Preferences tab.
4 Select Confirm Profile Save.
5 Choose OK to activate the new setting and close the Options dialog.
Next time you exit from Kurzweil VoicePad, it will ask whether or not you want to save 
your voice profile.

See Also
Creating a Voice Profile 
Selecting a Voice Profile 
Saving Your Voice Profile 



    Deleting a Voice Profile    
A voice profile takes approximately 6 MB in disk space. You should delete any voice 
profile that is no longer in use to recover disk space. 

Note: You permanently lose any adaptation for that profile when you delete 
it.

To delete a voice profile
1 Open Kurzweil VoicePad.    The Start User dialog appears.
2 Select the user name from the list.
3 Choose Delete.
4 Choose Yes to confirm that you want to delete the voice profile for the selected user 

name.

See Also
Creating a Voice Profile 
Selecting a Voice Profile 
Saving Your Voice Profile 



    Contents 
Choose a topic below to display the contents. For Help on Help, press F1
Kurzweil VoicePad Registration and Evaluation
Registering and Evaluating Kurzweil VoicePad.
Upgrading to Kurzweil VOICE
Learn how to upgrade to Kurzweil VOICE so you can voice-enable any Windows application.
About Kurzweil VoicePad Help
Differences between this Help file and the complete Help file for Kurzweil VOICE
First-Time Users
Learn all about Kurzweil VoicePad and how to use it.
Kurzweil VoicePad Basics
Learn about Kurzweil VoicePad windows, as well as dictating, correcting, and speaking commands.
Opening Command Cue Cards
Learn how to display cue cards to remind you of frequently used dictation commands.
Customizing Kurzweil VoicePad
Learn how to add words and commands to customize command lists.
Tuning and Troubleshooting
Learn how to fine tune recognition performance, solve misrecognition problems, and maintain voice
profiles.
Using Kurzweil VoicePad Hands-Free
Learn how to use the hands-free capabilities of Kurzweil VoicePad.
Reference
Contains information about Kurzweil VoicePad windows and menus.
Examples
Learn how to use Kurzweil VoicePad by example. 



 Kurzweil VoicePad License and Warranty Agreement
Kurzweil VoicePad is not free software, it's shareware.    You are hereby licensed to use 
this software for evaluation purposes without charge for a period of 30 days.    If you 
use this software after the 30-day evaluation period, a $49.95 license fee is required.    
You can purchase a license by calling Kurzweil AI at 1-800-380-1234.    Payment can be
made by check or credit card.    When payment is received, you will be sent a copy of 
the Kurzweil VoicePad for Windows 95 Release 1.0 License and Warranty Agreement.
You are specifically prohibited from distributing, charging, or requesting donations for 
this software; and from distributing the software with other products (commercial or 
otherwise) without written permission.



    About Kurzweil VoicePad Help
This Help file provides much of the same information as Kurzweil VOICE Help, but you'll 
notice throughout that a number of links are unavailable.    Here are examples of what 
you'll see:
This underlined text is a working jump
This dotted-underlined text is a working pop-up
This green text islink that is available only in Kurzweil VOICE Help.



    Jump Destination
...which brings you to a related topic.    
Use the Back button to return to the previous topic.



Pop-up topic
...which diplays a definition or other explanatory material.



Upgrading to Kurzweil VOICE
If you would like to voice-enable other popular Windows applications, and benefit from a
larger active vocabulary, you can upgrade to the latest version of Kurzweil VOICE by 
calling 1-800-380-1234.



     Using the Correct That Window 
Use the Correct That window to correct a word that Kurzweil VoicePad misrecognized. 
Doing so helps Kurzweil VoicePad adapt to your speaking style.
To access this window
Say correct-that when a word or command you said is:

Not correctly inserted in your dictation (word) or executed (command).
Not offered as an alternative in the Take window.

To use this window
1 In the Take Keys text box, begin typing the word or command you said or spelling it by

voice alphabet. As you enter the letters, alternatives appear that match the letters 
you type. 

2 If the word you said does not appear, go to step 3. 
If the command you said does not appear, got to step 4.
If the word or command does appear:

In the Take-Best position, say take-best.
As a numbered alternative, say take- and the number. For example, say take-3 as 
one phrase.

3 If the word does not appear but:
A root form of the word does appear, say endings-of- and indicate which 
alternative.    For example say endings-of-best or endings-of-2.
Another spelling of the word does appear, see Changing the Way Kurzweil VoicePad 
Spells a Free Text Word.
You have spelled the word completely in the Take Keys text box, say take-keys.    
Doing so adds this new word to your free text vocabulary.

4 If the command does not appear:
It is either not active in your current location, or it is not a valid command.    Exit 
from the Correct That window and verify the command using the Active Words 
window to find what you can say.

See Also
Correcting:    Fixing Kurzweil VoicePad Misrecognitions 
Using the Endings-Of-Command
Using the Active Words Window
Adding a Command



    Help on Deaf on One Word
Select the word from the list that Kurzweil VoicePad never recognizes and train it.
To solve this problem
1 Enter the word in the list that Kurzweil VoicePad never recognizes. When the word 

appears, select it. 

Note:    If the word does not appear, it is not trained. To correct this problem, 
exit from the Wizard and train the word or command using the Active Words 
window.

2 Choose the Solve button. The Train Word dialog box appears.
3 Follow the prompts to train the word. If you need help, choose the Help button.



    Help on One Word Intrudes No Matter What You Say
Select the word from the list that intrudes when you are dictating and train it.
In addition to the Wizard's solution

Use the take- and correct-that commands to help Kurzweil VoicePad learn the 
word and adapt to your voice.
If you do not think you will be using the word in your dictation, delete the word 
using the Active Words window.

To solve the problem
1 Scroll to or begin typing the word that Kurzweil VoicePad continually recognizes for 

other words. When the word appears in the list, select it. 
2 Choose the Solve button. The Train Word dialog box appears.
3 Follow the prompts to train the word. If you need help, choose the Help button from 

this dialog box.



    Help on Hears You When You Are Not Speaking
The Wizard has three solutions to this problem. It is important that you complete a 
solution and then use Kurzweil VoicePad to determine whether the solution improved 
recognition. If it did not, follow the next action listed. 
In most cases, completing Solution 2, raising the match threshold, should solve the 
problem.
In addition to the Wizard's solution

Eliminate unnecessary background noise. 
Turn off the microphone when you are not speaking; Kurzweil VoicePad 
eavesdrops.

To solve the problem try these three solutions in order

Solution 1 – Check Sound Levels
1 Choose the Solve button. The Sound Levels dialog box appears.
2 Follow the prompts. When you finish, Kurzweil VoicePad automatically exits from the 

Recognition Wizard.
3 Use Kurzweil VoicePad. 
4 Evaluate recognition. If Kurzweil VoicePad still hears you when you are not speaking, 

go to Solution 2.

Solution 2 – Raise the Match Threshold
1 Choose the Next button. The Wizard displays the Match Threshold solution.
2 Choose the Solve button. Kurzweil VoicePad automatically raises the threshold 

setting.
3 Choose OK.
4 Use Kurzweil VoicePad. 
5 Evaluate recognition. Do one of the following until the problem is eliminated. Go to 

Solution 3 only if you need to make Kurzweil VoicePad less sensitive to sound.
If Kurzweil VoicePad Then
Still hears you when 
you are not speaking

Repeat Solution 2.

Doesn't hear you at 
all

Choose Occasionally Does Not Hear 
You from the list of problems.

Dometimes doesn't 
hear you

Choose Occasionally Does Not Hear 
You from the list of problems.

    Help on Occasionally Does Not Hear You
The Wizard has three solutions to this problem. It is important that you complete a 
solution and then use Kurzweil VoicePad to determine whether the solution improved 
recognition. If it did not, follow the next action listed. 
In most cases, completing Solution 2, lowering the match threshold, should solve the 
problem.
In addition to the Wizard's solution
Pause between words and phrases.



To solve the problem, try these three solutions in order

Solution 1 – Check Sound Levels
1 Choose the Solve button. The Sound Levels dialog box appears.
2 Follow the prompts. 
3 Use Kurzweil VoicePad. 
4 Evaluate recognition. If Kurzweil VoicePad still does not hear you, go to Solution 2.

Solution 2 – Lower Match Threshold
1 Choose the Next button. The Wizard displays the Match Threshold solution.
2 Choose the Solve button. Kurzweil VoicePad automatically lowers the threshold 

setting.
3 Choose OK. 
4 Use Kurzweil VoicePad. 
5 Evaluate recognition. Do one of the following until the problem is eliminated. Go to 

Solution 3 only if you need to make Kurzweil VoicePad more sensitive to sound.
If Kurzweil VoicePad Then
Still does not hear you
when you speak

Repeat Solution 2.

Hears you when you 
are not speaking 

Choose Hears You When You Are Not 
Speaking from the list of problems.

    Help on Does Not Hear Anything You Say 
The Wizard needs to perform a sound levels check to correct this problem. 

Note:    In rare cases your sound board may be the cause of this problem, and
the Recognition Wizard's solution can't help you.    See Troubleshooting a Deaf 
Microphone for more information.

Before you use the Wizard
Make sure you have the microphone plugged in correctly.
Check the status message in the Kurzweil VoicePad main window's Last Word 
Heard panel. If the message "Say listen-to-me" appears, say listen-to-me. This 
message indicates that you have turned the microphone off with the stop-
listening command.

To solve the problem using the Wizard
1 Choose the Solve button. The Sound Levels dialog box appears.
2 Follow the prompts, or choose the Help button for more information.



    Help on The Status Line Says “Too Loud”
You are either speaking too loudly or the background noise in your environment is too 
loud. Exit from the Wizard and do either of the following:

Speak in a normal tone when you use Kurzweil VoicePad. If you still experience 
the problem, speak lower; but don't whisper.
Eliminate any background noise you can.



    Help on The Status Line Says “Too Long”
Follow the instructions below to let the Wizard adjust some of Kurzweil VoicePad's 
recognition settings to correct this problem.
To solve the problem, try these two solutions in order

Solution 1 – Check Sound Levels
1 Choose the Solve button. The Sound Levels dialog box appears.
2 Follow the prompts. 
3 Use Kurzweil VoicePad. 
4 Evaluate recognition. If the problem persists, go to Solution 2 only if you need to 

make Kurzweil VoicePad less sensitive to sound.

Solution 2 – Lower Sensitivity Level
1 Choose the Next button. The Lower Microphone Sensitivity solution appears.
2 Choose the Solve button. Kurzweil VoicePad automatically lowers the sensitivity level.
3 Choose OK.



sensitivity level
Setting that determines how sensitive Kurzweil VoicePad is to background noise.



    Help on Hears Noise as a Word
Train the noise that Kurzweil VoicePad consistently recognizes as a word.

Tip: If you have selected the Auto Confirm Training option, the microphone 
will be on when you choose the Solve button. Be ready to reproduce the 
noise.

To correct this problem
1 Choose the Solve button. The Train Noise dialog box appears.
2 Follow the Train Noise prompts. If you need help, choose the Help button.



    Help on Generally Poor Recognition 
If the problem you are having does not appear on the list, use this solution to let the 
Wizard make some adjustments.
In addition to the Wizard's solutions
Use the take- and correct-that commands to help Kurzweil VoicePad adapt to your 
speaking style.
To solve the problem
This problem has three possible solutions. Complete the steps for the first solution. If 
the problem persists, access the Recognition Wizard and complete the steps for the 
other solutions.

Solution 1 – Check Sound Levels
1 Choose the Solve button. The Sound Levels dialog box appears.
2 Follow the prompts. 

Solution 2 – Train the KV Dictation Commands
1 Choose the Next button. The Train KV Dictation Commands solution appears.
2 Choose the Solve button. The Training dialog appears.
3 Follow the screen messages and prompts to train the list of approximately 50 

commands.

Note: If you exit from training before you complete recording samples for the 
entire list, you will not lose the samples recorded.    Future recognition will 
benefit from those samples.    If you access this solution later to finish the list, 
however, you will be prompted from the beginning of the list.

Solution 3 – Verify Gender
1 Choose the Next button twice. The Verify Gender solution appears.
2 Choose the Solve button. A dialog box appears with your voice profile gender (or 

Child setting).
If the setting is incorrect, choose Current User from the Kurzweil VoicePad main 
window menu and change the gender setting.

3 Choose OK to exit.

See Also
Help on Current User 



    Help on Does Not Hear Me Correctly When I Say Numbers
Read the two solutions offered by the Recognition Wizard. Then try dictating.
If you still experience problems, review Phrasing Numbers for the rules when dictating 
numbers.



    Help On Reset All Values to Default Values
If you mistakenly changed a recognition setting, such as the sensitivity level, select this
option. The Wizard resets all the Kurzweil VoicePad recognition settings. 
To reset your default values
1 Choose the Solve button. The Wizard resets your match threshold value.
2 Choose OK to exit.



    Help on Training Words
The Train Words option lets Kurzweil VoicePad adapt to your voice by recording samples 
of you speaking the word or command.
To train words
1 Say the word that appears at the prompt.
2 Choose one of the following:

Continue button to save the sample and record the next sample.
Backup button to record a new sample if you do not think the sample reflected the 
way you speak. Repeat steps 2 and 3.

3 Record additional samples as prompted by Kurzweil VoicePad.
4 Choose OK when you have finished.

Hands-Free Users:    To train without having to press a button to continue, 
select the Train Without Confirms option on the Preferences tab of the Options 
dialog.



    Help on Training a Noise
To correct this recognition problem, you need to reproduce and record the noise so 
Kurzweil VoicePad will ignore that noise in the future. Keep the microphone in its normal
position during this recording. 

Tip: If you have selected the Train Without Confirms option, you do not need to 
press the Continue button to turn on the microphone.

To train a noise
1 Press the Continue button if necessary.
2 Reproduce the noise.
3 Choose one of the following:

Continue button to save the sample.
Backup button to record a new sample if you do not think the one recorded was an 
adequate sample. Repeat steps 2 and 3.

4 Press OK. 



    Help on Does not Recognize Your Word
Select the word from the list that Kurzweil VoicePad does not recognize and train it.
In addition to the Wizard's solution

Use the take- command to help Kurzweil VoicePad adapt to your voice.

To solve this problem
1 Enter the word in the list that Kurzweil VoicePad doesn't recognize. When the word 

appears, select it. 

Note:    If the word does not appear, it is not trained. To correct this problem, 
exit from the Wizard and train the word or command using the Active Words 
window.

2 Choose the Solve button. The Train Word dialog box appears.
3 Follow the prompts to train the word. If you need help, choose the Help button from 

this dialog box.



    Glossary      
This glossary is available if you upgrade to Kurzweil VOICE.
A
active window
Active Words window
adaptation
add-space command
alternatives
ambient noise
Application Editor
application command file (.VOC)
auto-cap- commands
auto-spacing- commands

B
background noise
back-up- command
back-up range

C
capitalization commands
client, network
close- commands
Command Learning
command lists
commands
context
continuous digit dictation
control-menu commands
correct-that command
Correct That window
current word

D
deafness
delete-space command
delete-that command
dialog box labels
dialog properties
discrete number-word dictation

E
end punctuation
endings-of- commands
enrollment
extended keys
extraneous noise

F
forward- commands 



fractions
free text vocabulary
free text words
G
gain, microphone and sidetone

H
I
initial-cap commands
insertion point
intrusive noise

J
K
Keyboard window
Kurzweil VOICE Center window
Kurzweil VOICE commands

L
Last Word Heard panel
listen-to-me command
lowercase- commands

M
match threshold
maximize/minimize buttons
microphone gain
microphone indicator
misrecognition
Mouse window
move-on command

N
navigation keys
network client
network server
noise

O
open- commands
Options dialog

P
pixel
pop-up menu
pretrained words and commands

Q
R



recognition tuning
Recognition Wizard

S
server, network
shortcut commands
sidetone gain
sound-levels command
spacing commands
speaking style
speed:accuracy ratio
speaker-independent words
stop-listening command
system-menu commands

T
take- commands
Take window
trained word or command
training

U
untrained commands
uppercase- commands

V
.VOC file
vocabulary, free text
voice alphabet
voice-enabled application
voice profile

W
word gap

X
Y
Z




